Content Publishing

Content Publishers are the users who create and mani pul ate content within the system.
Their job is to manage the information. The Content Publisher’'sview isreally an
extension of the user’s My Portal view, in that elements of the content managed in
Content Publishing mode can be viewed and extended through the My Portal
interface. By default, all My Portal users are Content Publishers; however, access
controls set by other Content Publishers or the Administrator may limit their
capabilities and access within the content.

The InfoPortal Database is arranged in most installations by Category. Each of these
categories corresponds to afolder on the Document Root of the server. Documents
may be stored within each of these Categories by their sub-type. For example, a
company that has operations in many countries may have their categories segmented
out by the country, with sub-categories within each country for various types of
documents (reports, travel brochures, etc.). The Category model allows quick sorting
of documents and objects within the system so that users can easily find itemsviaa
simple drill-down process, or viasearch. (Thisis covered more specifically in the
Overview of this document). The Content Publisher has the ability, where assigned by
the Administrator or other Content Publishers, to modify both the folder and category
structure of the system, aswell as the files within those categories.

In addition, InfoPortal allows the storage and search of “metadata,” or information
about each document or item in the repository. These are customized by the system
Administrator for each implementation of InfoPortal. However, the basic ideais
constant—information about the item that may or may not be available in the
document itself can be stored with the document and searched upon.

This section of the User’'s Manual contains a set of functional overviews (pages 3.2 to
3.15) followed by step-by-step how-to information for each function. The overviews
for each function include reference pages to the full function explanation in later

pages.
Content Publishers can use InfoPortal’s browser interface and point-and-click tools to:

e Add and delete folders and files as set by the Administrator or other Content Pub-
lishers

 Make PDF Renditions (Acrobat copies) of uploaded documents

e Check In and Check Out versions of documents and view the previous versions of
those documents

e Check and modify Access Control (document- and file-level User and Group access

rights)

»  Set, modify and delete Agents, which can notify both users and groups of specific
events within the content of the system

e Convert and OCR scanned documents (in TIFF format) to Adobe Acrobat PDF
(with optional Glyphica Satellite server)

* View, update and edit file and folder metadata

e Search by full-text content and associated metadata

InfoPortal
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Logging In

Logging In

Note 1. Start InfoPorta by opening your Internet browser.

The startup addressfor 2. Enter the following URL, replacing [machine name or |P address] with either the
S e e s s hostname or |P address of the InfoPortal server:

case-sensitive. To http://[ machine name or | P address]/infoportal/
access a Solaris
machine, enter
http://machinename/
infoportal

where infoportal isall Go to: http: /7209.111.111.111 finfoportal =]
lowercase. Using capi-
tal letters anywherein
the name will cause
startup to fail. &ddress |@ http: 44209.111.111.111 finfopartal j

« Of the following examples, the first illustrates the Netscape interface and the sec-
ond, Internet Explorer:

e TheLogin screen displays:

GLYPHICA

To access Infoportal

, please sign in.

Usernarme: I

Password: | O

@

3. Enter the username for your profile and press the Enter key.

4. Enter the password for your profile and press the Enter key, or click on the Sign In
button.

e Thiswill start your InfoPortal session.

» |f you need additional help with this screen, click on the question mark icon
located below the word “ Password”.
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Logging In

e TheMy Portal view displays:

@searcH  PHELP (@ sHow LNEIEIE] -

GLYPHICA

Document Review Process -]
My Sales 7 Technical Documentation 0 ¥ Sent for review (0]

. AR
Desk 7 Portals General Info 0 S Gveii o el ()

e Please review and comment fip logo srrwt. gif

Edit

Log Out Desktop Reminders (0

5. Sdect Content Publishing from the Show menu.
» The Content Publishing view displays:

{Yrerresh @ SEARCH  PHELP {8 sHow MEIGCINQSNA T LII

hotme :
GLYPHICA
» home
| Documentation || | Portal Info
Technical Documentation Portals General Info
|| [ Lori's
\:‘-)@ Mew Feature Wishlist

Name ————Pie Tl ockedby

@ gly logo smhorie gif

B Glyphlog ipg Log files
‘) index html
Tl ip logo smwt gif InfoPortal logo
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Interface Description and Functional Overview

Interface Description and Functional Overview

The Content Publishing view contains the following areas:

e Side Navigation Bar
e Top Navigation Bar
* Content Area

Content Publishing Side Navigation Bar

The Side Navigation Bar islocated on the left-hand side of the Content Publishing
screen.

GLYPHICA

File

Agent

The Side Navigation Bar contains the following main menu items:
File

Edit

View

Properties

Discussions

Mailboxes

Output

Agent

Menu items that contain a submenu display agreen triangle B (o thel&ft of the menu
name.

The following tables list the menu links in the Side Navigation Bar, a description of
the function of each link, and where you can find the related tasks for step-by-step
instructions.
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File Menu

Menu Item

Description

Associated Tasks

New

» Category

* Topic

* Review

» Subscribe

Add
e Document

* Weblink

* to Projects

Lists the items you can create in
InfoPortal.

Displays the Add a Category screen,
where Content Publishers can create a
new category folder in the InfoPortal.

Displays the New Topic screen, where
Content Publishers can post messages
to an existing discussion group.
Displays the Document review screen
where Content Publisher can send a
document to be reviewed by other
users

Displays the subscription screen where
Content Publishers can subscribe to
content within InfoPortal

Displays the Add a Document screen,
where Content Publishers can upload
a document to the InfoPortal.

Displays the Add a Weblink screen,
where Content Publishers can setup a
link to a remote website.

Allows InfoPortal to add a selected
document or folder to the Projects box
on MyPortal

» “Creating a Category
Folder,” page 3.17

» “Creating a New Discus-
sion Topic,” page 3.18

* “Adding a Document,”
page 3.23

» “Creating a Web Link,”
page 3.26

File Menu

InfoPortal
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Edit Menu
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Edit Menu

You must select afolder or document in the Content Area before clicking on the edit
menu link. If you do not select an item first, you will get an error message similar to

the following:

localhost:82 - [JavaScript Application] [E3

Pleaze select at least one item.
Y'ou have selected O

Menu Item

Description

Associated Tasks

Cut

Copy

Paste

Delete

Rename

Check In

Moves folders and files from one loca-
tion to another. Cut does not take effect
until Paste has been performed.
Places a copy of the folder or docu-
ment in memory for pasting elsewhere
in the Portal. The folder or document
also remains in the current directory.
The new document will not have the
security settings and agents that were
assigned to the original document.

Places the document or copy of the
document, after cutting or copying, in
the current directory. While you can
perform multiple paste operations from
one Copy operation, you can only per-
form one paste after a Cut operation.
Removes the folder or document from
the InfoPortal. You cannot delete a
document that is under version control.
Also, you cannot delete a folder that
contains a version control document.

Displays the Rename screen, where
Content Publishers can change the
name of a selected document or folder.
You must select the document or folder
icon before selecting Rename.
Displays the Check In screen, where
Content Publishers can check in a new
version of a selected document under
version history.

» “Cutting a Document or
Folder,” page 3.26

» “Copying a Document or
Folder,” page 3.26

» “Pasting a Document or
Folder,” page 3.27

» “Deleting a Document or
Folder,” page 3.27

* “Renaming a Document
or Folder,” page 3.27

» “Checking In a Docu-
ment,” page 3.29




View Menu

Menu Item Description Associated Tasks
Check Out Displays the standard file download » “Checking Out a Docu-
screen, where Content Publishers can ment,” page 3.28

save the file to the local system. The
file is locked on the server under ver-
sion history until you or the Administra-
tor unlock it or check it back in. Content
Publishers must select the document
icon before selecting Check Out.

Subscription Displays the Notifiction Type screen * *Subscribing to a Docu-
where the user can change the sub- ment or Folder,” page
scription notification method or can 3.75*

unsubscribe to the document or folder.

View Menu

Menu Item Description Associated Tasks

List f)isplays folders and documents in a » “List View,” page 3.32
double column. The original document
icon is located to the left of the file
name, the PDF icon is to the right, and
the document title is below the file

name.
Report Displays folders and documents in a » “Changing the Document
single column with the headings Name, Report View,” page 3.32

Title, and Locked by. The original and
PDF file icons both display to the left of
the document name. The document
title displays to the right of the docu-
ment name. This is the default view.

Site Displays the directory structure in a * “Viewing the Site Map,”
hierarchical view, much like the page 3.33
Microsoft Windows Explorer’s left
pane. Each directory title is a link to

that Category folder.
Discussions Displays a list of current Discussion * “Viewing a List of All Dis-
Groups on the InfoPortal. The list items cussions,” page 3.63

are links to the discussion groups.

Properties Menu

Properties

You must select afolder or document in the Content Areabefore clicking on the menu
link. Cut does not take effect until Paste has been performed. Cut effectively permits
you to move folders and files from one location to another, transferring agents and
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Properties Menu

security for the document in question. If you do not select anitem first, you will get an
error message similar to the following:

localhost:82 - [JavaScript Application] [E3

N

Pleaze select at least one item.
Y'ou have selected O

Menu Item

Description

Associated Tasks

General

Security

Check Links*

Version History

Displays the Document Properties
screen, where you can add, change, or
delete metadata for the selected docu-
ment or folder. You can also manually
lock/unlock the item from this screen.
In addition, the creation and last modi-
fied dates display here. Also, the size
information, and the created-on and
last-modified dates (extracted from the
server's operating system) display
here.

If you selected a document, the File
Permissions screen displays. If you
selected a folder, the Directory Permis-
sions screen displays. In both screens
you can view the current permissions.
You can also add, change, or remove
permissions from these screens.

Displays the Link Information for the
selected file or Category folder, where
you can verify the hyper links in PDF
and HTML files for targets both within a
document and outside the document.
* This menu option does not apply to
weblinks.

Displays the Version History screen,
where you can view multiple versions
of the same document. You can also
delete older file versions from this
screen. Note that a new version is
automatically created when a docu-
ment is moved from its original loca-
tion.

* This menu option does not apply to
weblinks.

“Adding, Changing, and
Deleting Document or
Folder Attributes,” page
3.39

“Manually Locking/
Unlocking a Document or
Folder,” page 3.41

“Adding File Permis-
sions,” page 3.46
“Changing File Permis-
sions,” page 3.50
“Removing File Permis-
sions,” page 3.51
“Adding Category Permis-
sions,” page 3.52
“Changing Directory Per-
missions,” page 3.57
“Removing Directory Per-
missions,” page 3.58
“Checking PDF and
HTML Links,” page 3.59

“Viewing Document Ver-
sion History,” page 3.60

“Deleting an Older Docu-
ment Version,” page 3.61
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Output Menu

Output Menu

Dutput
# Generate PDF

o MultiTiff 2 PDF
# Frint

The Generate PDF link allows Content Publishersto make PDF Renditions of existing
documents of many formats. If the document was not Renditioned during the Add
Document process, it may be converted manually to PDF format using thistool.

In addition, InfoPortal allows the conversion and Optical Character Recognition
(OCR) of scanned paper documents in TIFF format. Content Publishers may scan
documents directly into an InfoPortal Category folder, then use MultiTiff2PDF to set
the order of the documents, run OCR against them, and make machine-searchable
Image+Text Adobe PDF documents.

The Print link allows server-side printing. Content Publishers can choose a particular
document, or set of documentsin afolder, and request InfoPortal Server to print the
documents to a network-attached or hardware-attached printer.

You must select adocument in the Content Area before clicking on the menu link. If
you do not select an item first, you will get an error message similar to the following:

localhost:82 - [JavaScript Application] [E3

Pleaze select at least one item.
Y'ou have selected O

Menu ltem Description Associated Tasks
Generate PDF Automatically generates an Adobe “Generating a PDF Rendi-
Acrobat PDF, fully-text-searchable doc- tion,” page 3.71
ument from a selected file. You can
select only one item at a time for this
function (multiple file selection is not
allowed).
MultiTiff2 PDF Automatically generates a machine- “TIFF to PDF Conversions,”
searchable PDF document from single  page 3.71
or multiple TIFF files. Use this method
to convert scanned paper documents.
Print Displays the Print Files screen, where “Printing a Single Docu-
you can select the order of printing, ment,” page 3.73
select a printer, the number of copies,
and print the selected document(s).
Agent Menu

Angen
Agentsalow Content Publishersto set complex search- or criteria-driven notifications
on categories or individual files within the InfoPortal, and send those notifications to
specific users and/or groups, or to their own myportal windows.
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Top Navigation Bar

You must select afolder or document in the Content Areabefore clicking on the menu
link. If you do not select an item first, you will get an error message similar to the
following:

localhost:82 - [JavaScript Application] [E3

Pleaze select at least one item.
Y'ou have selected O

Menu Item Description Associated Tasks
Agent Sets up automatic notification when » “Agent Overview,” page
certain events occur. InfoPortal can 3.77
notify you either by email or My Portal.  « “Editing an Agent,” page
Events you can select: 3.85
« Created (does not apply to Discus- » “Enabling/Disabling an
sion Topics) Agent,” page 3.86
« Modified (does not apply to Discus-
sion Topics)
e Deleted

« View (agent not triggered by open-
ing a Discussion)*

Modified links

Checked links

Email arrived

Copied

Moved

* When you set a View Agent on adocument that opens within a frame, you do not receive
notification on your My Portal desktop or through e-mail, unless you manually reload
the frame that the document isin EVERY time you view it. Typically these documents
are cached (unless you change the cache preferences setting for your browser), and if
viewed a second time without refreshing, they will be pulled from the cache and will
not trigger another event. On the other hand, documents that open in a new browser
window trigger an event every time because the document is requested from the system
again rather than from cache.

Top Navigation Bar

A LTI U ST ORI Content Publishing -

See “Top Navigation Bar,” page 1.3 for adescription of the Top Navigation Bar.

An additional button displays in the Top Navigation Bar in the Content Publishing
view. The Refresh button displays the most current datain the Content Area. Typically
Content Publishers should click on Refresh after performing functionsin which a
document icon is selected first. This ensures that the icon is deselected.
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Content Publishing Content Area

Content Publishing Content Area

The Content Publishing Content Areaislocated to the right of the Side Navigation Bar
and below the Top Navigation Bar.

hotme
»home
' L Test Docs ' L =sevbold
Documents to Test Features seybold Test Docs
|" , MEDkm C@ Feature Wish List
WMEDkm
Portals

" Portal: General Info

Name " PTie ] Locked by

W Dizcussion Group Guidelines htm Discussion Group Guidelines

B # fags.himl Frecuently Asked Questions
'] Welcome. fin Welcome Message

W bookmark htrn

The Content Area contains three €l ements:

» Directory Path
* Folder List
e Document List

Navigation Path

The Navigation Path shows the current directory and its parent directoriesin a
horizontal line across the top of the Content Area.

home : Sales : Proposzals ; Fortune 100 ¢

Each directory nameisalink. You can click on any link to go immediately to that
directory. For example, if you click on the home link, you go directly to the home
directory.
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Folder List
Folder List
The Folder List islocated below the Directory Path area and above the document list
area. It contains all discussion document and group foldersin the current directory.
—
‘ »home
E A Test Docs E A =sevbold
Documents to Test Features seybold Test Docs
" MRDkm = Feature Wish List
WEDkm '
E A Diean Discussion
Mumber 3
E A Portals
FPortals General Info
The Folder List looks the same whether you arein List or Report view.

FOLDER ICONS
Examples of document, discussion and mailbox folder icons are shown in the table

Icon Selected Explanation
Document Folder

below:

Icon
i =
] ]
Discussion Group

"_if"l

-
Mailbox

1798

e il
il
Hh

T

|@

FOLDER LINKS
E A Portals
FPortals General Info
To the right of each folder icon is an underlined title, which is afolder link. Clicking
on the link displays the contents of the folder in the Content Area.

Document List

The Document List islocated below the Folder List area. It contains all documents
and weblinksin the current directory.
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Document List

The Document List looks different depending upon whether you are in List or Report
view.

Report View:

Name T Tie ] Locked by

W Dizcussion Group Guidehnes htm  Dizcussion Group Guidelines

B # fags.himl Frecuently Asked Questions
il Welcome fin ‘Welcome Message Julie

W bookmark htrn

Elements of the Report View:

e Document typeicon

« PDF Renditionicon, if any
* Filename

* Document metadatatitle

e If locked, by whom

List View:

T Discussion Group Guidelines htm
Dizcussion Group Guidelines

W fags html
Frecuently Asked Questions

&l Welcome fin
Welcome Message

T bookmark htm

Elements of the List View:

« Document typeicon

¢ Filename

« PDF Renditionicon, if any
* Document metadatatitle

DOCUMENT ICONS

Within document folders, document-type-specific icons show the original format of
documentsin the InfoPortal by displaying the industry-standard icons for these
document types. Examples are shown in the tables that follow.
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Adobe Acrobat Icons:

Icon Explanation
Adobe Acrobat PDF file is the only available format for viewing. The icon dis-
ﬁ plays to the left of the document title.

: Adobe Acrobat PDF file has been created froma different format. The icon
displays to the right of the document title, and is a supplementary link to the
original document.

Icon Icon Selected Explanation

Adobe Acrobat PDF file
#e W

HTML document file

rgu
o EE" Word document
PowerPoint document
Excel document
=3 % o
= Generic document such as text, zip, gtf
GIF image file
GIF GIF
| ]
TE_ T TIFF image file
JPEG image file
1
' U

DOCUMENT LINKS
To the right of each document icon is an underlined title, which is a document link.
Clicking on the link displays the contents of the document in the Content Area.

Report View:

W Discussion Group Discussion Group Cuidelines
Cuidelines him

B tramineadshides ppt Traiing Presentation
Welcome. fin Welcome Message




Content Publishing Tasks

List View:

T Discussion Group Guidelines htm
Dizcussion Group Guidelines

9 tramingadslides ppt
Traiing Presentation

& Welcome fin
Welcome Message

Content Publishing Tasks

This section of the Users Manual details each of the functions of the Content
Publishing mode of InfoPortal.

Adding an Item to your My Portal Window

This procedure places alink to the selected folder or document in a selected window
of the My Portal view. (The folder or document remainsin its original placein the
InfoPortal). The MyPortal window is essentially a set of organized, categorized
shortcuts to the content contained within InfoPortal. It isa*“ control panel” from which
each user can customize viewsinto the system, and make it easy to get to the content
that is most important to that user.

Thisisa shortcut feature so you can access documents you are working on from the
first screen after you log in. You can use this procedure for any My Portal window,
except for Document Review Process, Desktop Reminders, and Subscriptions (these
three windows are self-updating from other functions within the system).

1. Inthe Content Area click on the folder or document icon to select it.
e You can select multiple items.
e A check mark displays on theicon.

W Discussion Group Guidelines htm Discussion Group Guidelines

(4

2. Inthe Side Navigation Bar, click on the File menu triangle to expand it.
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Deleting an Item from a My Portal Window

3. Click on the appropriate “Add to” link.

* Addto Contentsis provided with InfoPortal; you may see additional linksin the
My Portal menu, depending on your particular installation.

» A confirmation message displays:

localhost:82 - [JavaScrpt Application]

& Digcuszion Group Guidelines. htm haz been added

4. Click onthe OK button.

5. Click on the Refresh button m to deselect the document icon in the Con-
tent Area.

» Thefolder or document now displaysin the selected window of the My Portal
view.

Contents ()

L home 9
B Discussion.. roup Cuidelines

e The document title may be shortened due to window size (the window cannot be
resized).

Deleting an Item from a My Portal Window

This procedure deletes the My Portal window shortcut for a folder or document. (It
does not delete the original folder or document from its place in the InfoPortal). The
figures show the Contents window, which is provided with InfoPortal; your specific
installation may contain additional windows. You can use this procedure for any My
Portal window, except for Document Review Process, Desktop Reminders, and

3.16 InfoPortal




Creating a Category Folder

Subscriptions, which automatically update their contents based on other operations
within the system.

1. Select My Portal from the Show menu drop-down list.

e TheMy Porta view displays:
@ sEARcH  PHELP @ sHOW My Portal =

_ Contents (2)
My Sales ) M
Desk Y Discussion . roup Cuidelines eskinpiteniotesil

GLYPHICA

|,‘/'“ My Euntacts_‘_:l

r?-’- ToDo List )
Logged in as admin

y, August

2. Inthewindow that contains the shortcut, click on the [ to the right of the folder or
document title you want to delete.
« A confirmation message displays.

hyperstate - [JavaScript Application] [E3

@ Remove from folder?
Cancel |

3. Click onthe OK button.

e The shortcut is removed from the selected My Portal window. It is not removed
from the Portal content; only the shortcut to the folder or document is removed.

Creating a Category Folder

This procedure creates a Category Folder (directory) in the InfoPortal. The directory
displays as afolder icon with a name that you provide. Use Categories to organize
information within the system in alogical hierarchy. For example, if you have
documents representing information concerning five clients, you may wish to make a
Clientsfolder, with five subfolders, one for each client. InfoPortal's search functions
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Creating a New Discussion Topic

Note

Only Site Administra-
tors can create new
Discussion Groups.
Content Publishers
may participate in
groups and add new
topicsto groups.

3.18 InfoPortal

will allow you to limit your searches within the Portal to this category and/or its

subcategories.

(To create a Discussion Group Folder, see “Creating a New Discussion Topic,” page
3.18)

1. Navigateto the directory where you want to create the Category Folder.

2. Click on the File menu; look under New.

3. Click on the Category link.

e The Add a Category Under screen displays:

Add a category under

/

Faolder name |
Title |
Submit | Clear |
4. Typeaname for the directory in the Folder name field (Do not use spaces or odd
characters—! @#$%"& * (). Underscores are acceptable.)
5. Enter atitle for the document in the Title field.

« ThisTitleiswhat will display in the InfoPortal view and in the Website-like
“user” view. The Title does not have to match the filename; rather, it can be much
more descriptive and as long as necessary.

6. Click on the Submit button.

e The Category Folder is created and the folder name displays as alink to the
folder contents.

Creating a New Discussion Topic

This procedure posts atopic to a Discussion Group.

1
2.

3.

Navigate to the Discussion folder.
In the Side Navigation Bar, click on the File menu triangle to expand it.

w Document

Click on the New Topic link.




Creating a New Discussion Topic

* The New Topic screen displays:

Mew Topic

Your Mame: david

Email Address: david@glyphica.com
Subject: |

Attachment: S | Bruwse..:l

Fost Msg | Cancel Post | Clear M=g |

-

Enter atitlein the Subject field.
(Optional) Click on the Browse button if you want to include an attachment with
your message. Only one file can be attached to a message.

e TheFile Upload window displays:
File Upload EHE|
Look. i I 3 MyContent j ﬁl

b2 Discussion Group Guidelines. ktm
sipr Glophica web site. htm

% pdftshaoting. html
bkt WebSites htm

File name: I Open I
Filez of type: IHTML Filez j Cancel |

Locate the file and select it.
Click on the Open button.
e The path and filename display in the Attachment field of the New Topic screen:

Attachment: %ID:\MyEnntenhGlyphica nebzite Bruwse..:l
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Start Review of a Document

8. Enter your message in the text area bel ow the buttons.
9. Click on the Post Msg button.
* The message displays asalink in the Discussion folder:

D 5% home : Portal Info ; Ideas for Portal Content

ldeas for Portal Content

D Search Field % cadming Fri, 13 Aug 1000 23:57 56 SMT

QO

Start Review of a Document

The document review process is a powerful workflow tool. In general, the function
alows a Content Publisher to select a document, list in order the other Content
Publishers (or entire Groups of Content Publishers) who should review the document,
and then initiate areview process.

Each Content Publisher will receive a MyPortal notification in their Document
Review window when it istheir turn to review the document. They can add comments
to the document.

When the review processis finished, the Content Publisher who initiated the Review
will be notified. The Initiator can also see the status of the review process, and from
the Review Process window even send emails to reviewers to remind them or ask
questions, etc.
1. Inthe Content Area, navigate to the directory where the document is located.
2. Click on the document icon to select it.

e A check mark displays on theicon:

Name g T Locied by

= PortalPlanting, doc Planning Portal Content

3. Inthe Side Navigation Bar, click on the Start Review menu.

4. Check on Review under the new heading.
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Start Review of a Document

» The Document Info/Review List screen displays:

Document Location
Moxls

Title
|F’Ieaae rerview and comment /1 xls
Motification:
¥ Desktap
¥ Email
Description
[—
[~

[ et

e TheTitlefidd displays the text that reviewers will seein their My Portal view.

If you wish to do so, enter a different title.

Click in the check boxesto check or uncheck the Reminder options you want to

receive when the review process is finished.

» Desktop puts amessage in the Desktop Reminders window of your My Portal
view when the review processis finished.

« Email sends you an email message when the review processiis finished. This
method allows notification when you do not have access to the Portal, but do
have access to email.

Click on the Next button.
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Start Review of a Document

» TheReview List tab displays:

Document Info Review List

Add | Remove

Save

8. Click on the Add button.
* The Search Users screen displays:

Search Users

|L|:|gin 10 j ||:|:|ntains j I =ubmit |

9. Enter search criteria (login ID, first and last name, ect) Click on the Submit button.
» Thelist displays al usersin the system that meet your search criteria.

Search Users

|L|:|gin 10 j ||:|:|ntains j I =ubmit |
Login 1D Firstname Lastname

Add  diane Diane Jdankowsk

Add  john ] ]

Add  bob d d

Add  david David Zoleman

Add  julie dulie Zallahan

Add  wirginia Yirginia dickson

Add  admin admin

10. Click on the Add link for the user(s) you wish to add to the Review List.

* Notethat selection order isimportant. The review noticeis sent in the same order
inwhich you select reviews from the Search Userslist. Thefirst user chosen gets
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Adding a Document

the document first, and no one el se gets notified until that person is done review-
ing it.
e After your selections, the User ID and names display in the Review List:

Document Info Review List
.............................................................................. =]
diane (Jankowski Diang)
david (Coleman,David)

=
Add | Remove
Save

11. Click on the Save button.
e A confirmation message displays.

Your request has been submitted.

* The system updates the Document Review Process window in your My Portal
view:

Document Review Process - |

w  Sent for review (1)
+ Please review and comment fPoral InfoPoralPlanning. doc

w  Aweaiting my approval (0
A,

Adding a Document
This procedure uploads a document to the selected Category Folder.

Content Publishers may add documents to existing Category folders at any time, if
they have the proper security rights (set by the Administrator or other Content
Publishers). The process described below may be considered “uploading” a document
to the system. The moment the document is added to the InfoPortal, the document and
its associated metadata are immediately indexed, and become available for search
within moments of the completion of the Add Document process.

In addition, this process allows the Content Publisher to make Adobe Acrobat (PDF)
“renditions’ or copies of many document formats. The reason for thisisthat if a
document is loaded in a proprietary format (PageM aker, for example), not all users
will have the application necessary for viewing the document. However, PDF format
isuniversally accepted and can be read by most computers. The PDF Rendition allows
any user, anywhere, to view the document no matter what its original format.

1. Navigate into the Category Folder where you would like to place the document.
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2. Click on the File menu.
3. Click on the Add Document link.
e The Add a Document screen displays:

Add a Document

Note:

PDF renditioning is
only available in
systems equipped with
an optional Glyphica
Satillite server.
Therefore, you may nit
see PDF rendition
messages.
customized metadara
sets, so what you see
here may be different
than what you seein
your InfoPortal.
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File name* | Browse... |
Author | ]
Diate | | Metadata
attributes
Eeywords |
Title |

Save | Clear |

Click on the Browse button to the right of the File name field.
Sdlect afileto upload.
* The selected file name displaysin the File name field.

¢ Required fields are marked with an asterisk (*). The other fields are optiona
metadata fields. Data put in these fields become searchable items.

Fill in the Author and Date fields, as well as any other relevant fields that display.

e The Datefield will accept most standard date formats, such as 11/29/99; August
7, 1999; 7 September, 2000. The dates will be converted to numerals so that Jan-
uary 9, 1999 will apear as 1999/01/09 00:00:00.

Type one or more words in the Keywords field.

» Keywords may or may not be necessary or useful, depending on your local
implementation of InfoPortal. Keywords are not case-sensitive. You can use any
character to separate the keywords and type as many keywords as heeded, since
thereis no sizelimit on thisfield.

Enter aTitle for the document in the Title field.

e ThisTitleiswhat will display in the InfoPortal view and in the Website-like
“user” view. The Title does not have to match the filename; rather, it can be much
more descriptive and as long as necessary.

Click on the Save button.
» If thedocument isin aformat that InfoPortal can convert to PDF, the following
message displays:

hyperstate - [JavaSchnpt Application] E3

@ Do you want to create a PDF rendition for this file?

Caticel |

» Formatsthat may be converted to PDF:




HTML

Microsoft Word
Microsoft Powerpoint
Microsoft Excel
Adobe FrameM aker
Adobe PageM aker
Text

10. Click on the OK button.

The document is created and the file name displays as alink to the document
contents. The Rendition icon will spin until the conversion process is complete

and the view isrefreshed.

Adding a Web Link

Name " Title | Lockedby

v

fag doc. hitml

Adding a Web Link

This procedure creates alink to aremote web site on the Internet. It displaysasa

chain-link icon with a descriptive title.

Frecuently Asked Questions

1. Navigate into the Category Folder where you would like to create the Web Link.
2. Click on the File menu.

3. Click on the Add Weblink link.

The Add a Weblink screen displays:

Add a Weblink

Weh link* [http:/

Luthor |
Date | Metadata
attributes

Eeywords |

Title™ |

Save | Clear |

4. Typethe URL of the web sitein the Web Link field.

You can aso copy the URL from the location field of your browser. Note that
InfoPortal already provides http:// as part of the Web Link field text, so you

should not copy that text.

Required fields are marked with an asterisk (*). The other fields are optional
metadata fields. Data put in these fields become searchable items.

5. Fill inthe Author and Date fields, aswell as any other relevant fields that display.

Note

The metadatafields
shown inthisAdd a
Weblink screen are the
defaults that ship with
InfoPortal 3.0. How-
ever, any implementa-
tion of the product will
include customized
metadata sets, so what
you see here may be
different than what you
seein your InfoPortal.
While Weblinks them-
selves are not search-
able within InfoPortal,
metadata associated
with Weblinks are
searchable.
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» TheDatefield will accept most standard date formats, such as 11/29/99; August
7, 1999; 7 September, 2000.The dates will be converted to numerals so that Janu-
ary 9, 1999 will apear as 1999/01/09 00:00:00.

6. Type one or more words in the Keywordsfield, if desired.
Type an aternate name for the Web Link in the Titlefield. Thisisarequired field.
8. Click on the Save button.

e TheWeb Link is created and the URL displays as alink to the selected website.

N

= hitpJfwww best.com BestVerio Web Site

Cutting a Document or Folder

This procedure moves a selected folder or document into memory. The folder or
document is removed from the current directory once the paste operation is
performed.

1. Inthe Content Area, click on the folder or document icon to select it.
e A check mark displays on theicon.

Name " Title | Lockedby

B # fag doc.himl Frecuently Asked Questions
2. Inthe Side Navigation Bar, click on the Edit menu triangle to expand it.

] F:-':rual:n-':
3. Click on the Cut link.
4. Continue with “Pasting a Document or Folder,” page 3.27.

Copying a Document or Folder

This procedure places a copy of the folder or document in memory for pasting
elsewherein the Portal. The folder or document also remains in the current directory.

1. Inthe Content Area click on the folder or document icon to select it.
» A check mark displays on theicon.

Name " Title | Lockedby

B # fag doc.himl Frecuently Asked Questions

2. Inthe Side Navigation Bar, click on the Edit menu triangle to expand it.
3. Click onthe Copy link.
4. Continue with “Pasting a Document or Folder,” page 3.27.
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Pasting a Document or Folder

This procedure places the document, or a copy of the document, in the current
directory after cutting or copying, respectively. When a document is copied or moved
from one directory within InfoPortal to another, all associated metadata is copied with
the document.

1. Inthe Content Area, navigate to the place where you want to move or copy the doc-
ument or folder.

2. Inthe Side Navigation Bar, click on the Edit menu triangle to expand it.
3. Click on the Paste link.

4. Click on the Refresh button to deselect the document icon in the Con-
tent Area.

Deleting a Document or Folder
This procedure removes the folder or document from the InfoPortal .

1. Inthe Content Area click on the folder or document icon to select it.
» A check mark displays on theicon.

Name Locked by
= AboutPortals. doc About Info Portals
) PortalPlanting, doc Planning Portal Content

2. Inthe Side Navigation Bar, click on the Edit menu triangle to expand it.
3. Click on the Delete link.
« A confirmation message displays.

localhost:82 - [JavaScript Application] [E3

@ Delete /Portal Info/dboutPortalz. doc?
] conca]

4. Click onthe OK button.
¢ The document or folder is removed from the Portal.

Name ————TTite | Lockedby

) PortalPlanting, doc Planning Portal Content

Renaming a Document or Folder
This procedure changes the file name of an existing document or folder.

(To change the metadata title, see “Adding, Changing, and Deleting Document or
Folder Attributes,” page 3.39.)

1. Inthe Content Area click on the folder or document icon to select it.

Note

Itisnot possibleto delete
adocument that islocked
by another Content Pub-
lisher. Also, it is not pos-
sible to delete a Category
folder if adocument
inside the folder islocked
by another Content Pub-
lisher.

Note

You cannot paste more
than once after adocument
has been cut.
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» A check mark displays on theicon.

Name " Title | Lockedby

B # fag doc.himl Frecuently Asked Questions

2. Inthe Side Navigation Bar, click on the Edit menu triangle to expand it.

3. Click on the Rename link.
e The Rename screen displays:

Rename

fag_doc. html to

Note Mew name: |
Changing the exten-

sion of adocument is Subrmit |

not recommended, as
it could result in the

corruption of the docu- 4. Type the new document or folder name, including the extension, in the New Name
ment itself or difficul- field.

tiesin viewing the 5. Click on the Submit button.

document.. R

The new file name displays in the Content Area.

Name " Title | Lockedby

B & fags.hitml Frecuently Asked Questions

Checking Out a Document

Checking Out a document isthefirst step in a set of procedures that are important to
the version history and control of adocument. Checking out a document places acopy
of the document on your hard drive or network drive, and at the sametime “locks’ the
filein the InfoPortal. Other Users and Content Publishers can still read the document,
but cannot delete it or modify it. Only the Content Publisher who has locked the
document (or the System Administrator) can unlock a document (either by manually
unlocking it—see “Manually Locking/Unlocking a Document or Folder,” page 3.41—
or by Checking In the document again—see “ Checking In a Document,” page 3.29).

1. Click on the document icon to select it.

3.28 InfoPortal




Checking In a Document

» A check mark displays on theicon.

Name e T Locked by

) InfoPortalDandd pdf InfoPortal 3.0 Q&AL

2. Click on the Edit menu triangle to expand it.
3. Click on the Check Out link.
» The application/download screen displays:

Unknown File Type E |

{}11 Y'ou have started to download a file of type
L

application/download

Click "Maore Info" to learn how to extend Mavigator's
capabilities.

Pick &pp... Save File.. Cancel

4. Click on the Save File button.
e The Save As screen displays.

Save As. . EHE |
Save jr: Ia Sales Tools j ﬁl

I:IEF'erDsaI_H ezOLICES]
1 Rt_Guide

Jdndexed

'E irmest, pdf

File name: IInfu:uF'u:urtaIE! anda, pdf Save I
Save az hupe: I.-'-‘-.II Files [*.7] j Cancel |

5. Navigate to where you want to save thefile.
6. Click on the Save button.

¢ Once the document is checked out, a blue padlock icon displays next to the file-
name in the InfoPortal (in Report view only):

Name e T Locked by

] TnfoPortalQandh pdf & InfoPortal 3.0 Q&A Jack

e Theuser ID of the person who checked out the document displaysin the Locked
By field. The document will remain locked until it is checked in again.

Checking In a Document

Once adocument has been checked out, you can work on the document in its native
application (MS Word, PageM aker, etc.), then place a new version of the document
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back in the InfoPortal using the Check In function. Once a new version of the
document has been Checked In, only the newest version will be visible to general
Users and other Content Publishers.

The only way to see the older versions of adocument isto specifically look up the
Version History of the document (see “Viewing Document Version History,” page
3.60).

There are two ways to do Check In:

e Addadocument to afolder (see “Adding aDocument,” page 3.23) in which the doc-
ument (same filename) already exists. If the folder is under version control, this
action will work as a check-in.

e Check in the document using the procedure described here; note that the filename
does not have to the same, as you have specified which document to check in.

1. Select the document to be checked in by clicking on itsicon in the Content Area.

» Thisselection becomesthetarget of the check-in. Thisway, if the document you
are checking in has a different name, InfoPortal will still check it in asanew ver-
sion of the selected document.

2. Click on the Edit menu triangle to expand it.

3. Click onthe Check Inlink.
» The Check In screen displays:

Check in under IDocumentation

Select a file: *

Comments: *

Submit | Clear |
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4, Click on the Browse button.
e TheFile Upload window displays:

File Upload HE
Look it Ia Sales_Tools j ﬁl

1 Propozal_Resources
1 Rt_Guide

InfoPortalld andd, pdf
irmest, pdf

File narme: IInfu:uF'u:urtaIE! andd, pdf Open I
Filez of type: I.-i'-.cru:ul:uat [*.pdf] j Cancel |

5. Select thefile format from the Files of Type drop-down list.
Sdlect the file to upload.
7. Click on the Open button.

e Thefilename displaysin the Select aFile field:

o

Check in under Training
Documents

Select a file: *

ID:'l.d-:--.':s’l.Sales_TnnIE’I.InfnPnrtaIDandA.pdf BTDWSE..J

Comments: *

Submit | Clear |

8. Typeasummary of the changes made (or other information) in the Commentsfield.  Note:
9. Click on the Submit button. The commentsfield is

« Thenew version of the document is checked in. (You can verify thisby checking ~ mandatory. If no com-

the document’s version history; see “Viewing Document Version History,” page ~ Mentsareincluded, you
will receive awarning

message and will not be
permitted to complete the
process without them.
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3.60 for details). Thefile, which was locked while a version was checked out, is
unlocked automatically after check-in.

Name e T Locked by

) InfoPortalDandd pdf InfoPortal 3.0 Q&AL

List View
This procedure displays the Content Area file structure in a double column.
1. Inthe Side Navigation Bar, click on the View menu triangle to expand it.

2. Click onthelList link.
e ThelList view displays.

home

’-_r home

L ACLTest C@ Hew Feature Wishhst
Arccess Control Test Folder

L Portal Info
Portal: General Info

Diocumentation
Techmcal Documentation
&= hito/wrwrw best. com B Glyphlog 1pe
EBestWerio Web Site
T indes hitrnl
T Discussion Group Guidelines htm
Dizcussion Group Guidelines akip logo smowt of

tramineadshides ppt
Traiing Presentation

Changing the Document Report View

This procedure displays the Content Area file structure in a single column, with the
individual documents displayed in atable that also shows title and locked-by status.
Thisisthe default view.
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1. Inthe Side Navigation Bar, click on the View menu triangle to expand it.

2. Click on the Report link.
¢ The Report view displays:

home

’-_r home

L ACLTest C@ Hew Feature Wishhst
Arccess Control Test Folder

L Portal Info
Portal: General Info

Documentation
Technical Documentation
Name
= hitpJfwww best.com BestVerio Web Site
W Discussion Group Guidelines htm Discussion Group Guidelines
tramineadshides ppt Traiing Presentation
¥ Welcome.fin Welcome Message
a oy lopo smhorie gf
B Glyphlog ipg
T index html

& i logo smowt oif

Viewing the Site Map

This procedure displays the Content Area directory structure in a hierarchical view,
much like Windows Explorer. Each underlined title isalink to that directory’s
contents.

1. Inthe Side Navigation Bar, click on the View menu triangle to expand it.
2. Click on the Site link
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Viewing Discussion Groups

This procedure displays the list of discussion groups within InfoPortal each
underlined title isalink to the discussion’s contents.

1

The Site view displays.

£ home

home

£ Extranet
Fem
“= Feature Wish List
) MRDkm
'_'__ EBenchmarl
' pest?
£ Letters

a8 Proposals
£ Portals

Test Docs

-
a8 speling
-

a8 presentations

In the Side Navigation Bar, click on the View menu triangle to expand it.

2. Click onthe Discussion link

The Discussion list displays..

5%  Select a forum to hrowse:

[P 3.0 Usability
Project Motes
TEst

Agreements
Mew product Discussion

The Discussion Window

Content Publishers use the Discussion window to post messages and read the content
of messages posted by other Content Publishers. These messages become discussion
“threads.” Discussions can only be added by Site or Account Administrators, though
Content Publishers can add topics and have full access to existing discussions. To
locate a discussion within the Portal collection, click on the Discussionslink under the
Edit menu. Thiswill display alist of discussions. Or, locate a discussion within a

category folder.




The Discussion Window

Content Publishers access the Discussion group by first clicking on a Discussion
Group link:

home : Tranng Documents

- -
" » Training Documents
Training Documents

fj-—f'{_{—.; suoeestions for Traning Topics

':'«‘:j-;"'{;_: y Tratming Format Preferences

o

This displays the Discussion Group topics:

home : Tranng Documents ;. Sugeestions for Tramme Topics

Suggestions for Training Topics

2 File/Folder Permissions gulie)wed, 25 Aug 1999 00:43:10 GMT

7 Attributes gadaiied, 25 Aug 1999 00:58:17 GMT

2 Document Feview Process imandived, 25 Aug 1999 00:59:37 GMT

7 Aents gohn)ived, 25 Aug 1999 01:00:45 GMT

0
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Navigation
Bar

Message
Content Area

Topic/
Message Area

3.36
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When Content Publishers click on atopic link, the Discussion window displaysin a
separate browser window:

mmdllG LY PHICA

Discussion

Suggestions for Training Topics

File/Folder Permissions (julie]ed. 25 Aug 1999 00:43:10 GMT

»

»

Note

It is possible to a
remove larger
quanitities of
versions
through the
operating sys-
tem of the
server. However
thisis highly
recommended
againgt, asthe
database pro-
gram that keeps

K

v

track of all
details concern-
ing afilewould
not be updated
in the event
archives were

o

I (== |

|Document: Done

The Discussion window contains three areas;

Navigation Bar
Topic/Message Area
Message Content Area

NAVIGATION BAR

PreviousTopic  NestTopic  Pravious Message

.7 Delete ¢

The Navigation Bar contains buttons that make it easier and faster for Content
Publishers to navigate in a Discussion Group folder. In addition, Content Publishers
can post response messages to an existing topic “thread.”

Button

Function

“Previous Topic
Next Topic
Previous Message
Next Message
Respond

Delete

Moves to the previous topic within the Discussion Group.
Moves to the next topic within the Discussion Group.
Moves to the previous message within the topic.

Moves to the next message within the topic.

Displays the New Response window, which allows Content Publishers
to create a subject/message to add to an existing topic thread. Once a
message is posted, its contents cannot be changed, and only the Site
Administrator can remove it.

Removes a topic or response message. Only the Site Administrator can
remove topics and messages.




TOPIC/MESSAGE AREA

The Topic/Message area displays on the left-hand side of the split window. It contains
the title of the Discussion Group, the topic, and alist of message links relating to that
topic. Attachments to messages display as a paper clip icon % to theright of the

message link.

Discussion

GLYPHICA

Suggestions for Training Topics

File/Folder Permissions % [david] Thu, 09 Sep 1000 21:486:28 GMT

. Full Day Session jjulie] Thu, 09 Sep 1999 21:52:40 GMT

.. Split sessions over two days (diane) Tho, 09 Sep 1999 215432 GMT

o o

Each message link displays the title of the message, the User ID of the person who
posted the message, and the date and time the message was posted. Clicking on alink
displays the content of the message in the Message Content area.

Thefirgt link in thelist is the topic link. Thislink displays the main message content
from which the discussion threads develop. The response messages are listed bel ow
the topic link in hierarchical order. Link titles preceded by one dot are on the first
level, titles preceded by two dots are on the second level, and so on. For example, in
the graphic above, “File/Folder Permissions’ is the topic. The message “Full Day
Session” is aresponse to the content in the first topic, “File/Folder Permissions.” The
message “ Split sessions over two days’ is aresponse to the content in the second-level
topic, “Full Day Session.”

The Discussion Window
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When a Content Publisher clicks on the Respond button, the Topic/Message area
displays the New Response screen:

Mew Response

Your Marme: Ken
Email Address:

Suhject: |

Attachment: %l Browse.. |

Faost bsg Cancel Post Clear Msg

—

[~

Content Publishers use the New Response screen to respond to the message that
displays in the Message Content area, the right-hand side of the split window.

MESSAGE CONTENT AREA

Authar: Julie

Fosted on: | WWed, 25 Aug 1999 00:48:10 GRT
Subject: File/Folder Permissions
Attachment:

Meed a training session covering system
Note defaults, inheritance, and how conflicts are
handled. "We should include a number of

Once posted, a mes- : .
typical scenarios.

sage's content cannot

be changed—not even

lo)i/ttr?sg si\agﬁ]m;f;_ The Message Content area displays on the right-hand side of the split window. When a
tor. The Site Adminis- Content Publisher clicks on atopic or message link in the Topic/M essage area, the
trator can delete a message displaysin the Message Content area. The Message Content areadisplays the
message, not change author of the message, the date the message was posted, the message subject, and the
it. message text. Thisareais read-only. It cannot be changed. If afile is attached to the

message, alink displaysto accessthefile.
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The Message Content area becomes a reference when creating aresponseto a
message in the New Response screen .(see “Responding to a Topic,” page 3.66):

Netscape

Discussion

GLYPHICA

MNew Response

four Mame: david Author: julie
Email Address: david@glyphica.com Posted on: | Wed, 25 Aug 1999 00:45:10 GhT
Subject: | Subject: File/Folder Permissions
Attachment; S | Bruwse..] Attachment:
Post Ms | Cancel Post | Clear Ms | Meed a training session covering system
J J defaults, inheritance, and how conflicts are
ﬂ handled. WWe should include a number of

typical scenarios.

E == | |Document: Done

Adding, Changing, and Deleting Document or
Folder Attributes

M etadata attributes, as mentioned in the Content Publishing overview, areinformation
about adocument, folder or item—such as aweblink or discussion group—which may
not be in the actual text of the document, but can be associated with it for the purposes
of search or description. For example, when searching it may be more useful to look
for a specific piece of information, such as Country, which may not be described in the
document but could have been associated with it during the document addition
process. Asyou work with this section of the manual, be aware that these document or
folder attributes can be as important as the documents they describe.

This procedure displays the metadata fields for afolder or document so you can add,
modify, or delete the information in those fields.

1. Inthe Content Area click on the folder or document icon to select it.
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» A check mark displays on theicon.

Name T Tie T Lockedby

- InfoPortalDandd pdf

2. Inthe Side Navigation Bar, click on the Properties menu triangle to expand it.

3. Click on the General link.
« The Document Properties screen displays:

Document Properties
{Training Documents/InfoPortal(Jand A pdf

Author |

Drate |1999£ 0s8/17 11:19:00

Description |

Eeywords |

Title I
Locked T
Created 058/24/9% 15:48:51
Last Modified 08/24/9% 16:33:58
Sire 240326

Save Cancel

17.0.137147

4. To add metadata, click in the appropriate attribute field and enter the information.

5. To modify metadata, highlight the information in the appropriate attribute field and
enter the changes.

Note 6. To delete metadata, highlight the information in the appropriate attribute field and
In order to make the press the Delete or Backspace key.
NGEar s 10 fhe meta- 7. Click on the Save button.
Metadatais usually » The Cancel button will reset any entries and return you to the Category view.
aDd:Cefr:;ﬂ r;,?g:;:\sdd 8. Click on the Refresh button m to deselect the document icon in the Con-
but documents moved tent Area.

into the portal in the
file system or Web
Dav may not have
metadta accaciated
with it.
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Manually Locking/Unlocking a Document or Folder

This procedure manually locks or unlocks a document or folder. Typically adocument
or folder is automatically locked and unlocked during check-out and check-in,

respectively.
1. Inthe Content Area click on the folder or document icon to select it.
» A check mark displays on theicon. Note;
. Thi I
Name very imited metedeta
~  InfoPortalQandé pdf InfoPortal 3.0 Q&.A set. Your view my
2. Inthe Side Navigation Bar, click on the Properties menu triangle to expand it. contian more fields.

3. Click on the General link.
e The Document Properties screen displays.

Document Properties
{Training Documents/InfoPortal(Jand A pdf

Author |

Drate |1999£ 0s8/17 11:19:00

Description |

Eeywords |

Title I
——» Locked [T
Created 058/24/9% 15:48:51

Last Modified 05/24/9% 16:33:58
size 240326

Save Cancel

17.0.137147

C . - Note
4. Tolock the document or folder, click inthe Locked check box. Thefield will display
Only the document/
acheck mark.
L folder owner and the
5. To unlock the document or folder, click in the Locked check box. S e e e &
6. Click on the Save button. unlock a locked docu-

« If you locked the item, the user 1D of the person who locked the item displays to ment or folder.
the right of thefield. In addition, a padlock icon displays next to the filename:

Name e T Locked by

] TnfoPortalQandh pdf & InfoPortal 3.0 Q&A Jack
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« |f you unlocked the item, the check mark will be removed from the field. The
user ID next to the field also isremoved, and the pad lock icon disappearing.

Name T Tie T Lockedby

] InfoPortalDandd pdf

Security (files and folders) Overview

Security settings allow Content Publishersto grant or restrict access to information or
categories by user or group. They also allow, through the use of the “hidden” function,
the ability for documents to be prepared without exposure in an area of the site and
then exposed to the correct users and groups by changing the status from “hidden” to
“visible.” Access controls are avery powerful tool for controlling the distribution and
visibility of information in the Portal, and it isimportant to fully understand how
Access Controls work before setting them inside the Portal. Most importantly, itis
necessary to review the functions of the controls and the order in which the controls
are executed by the system to make sure that improper controls are not set. Be sure to
review the sections on the following pages carefully in order to avoid granting access
to users who should not have access—or locking out those who should. After setting
access controll, it is usually agood ideato test the settings.

PERMISSIONS TARGETS
The following table lists the terms used in the Target field of the File Permissions and
Directory Permissions screens, and how they relate to usersin the system:

Target Name Corresponding System Users

Authors Content Publishers

Administrators Site Administrators

Subadmins Account Administrators

Allusers Content Publishers, Site Administrators, and Account Administrators

Other users groups may exist as well; the above example shows only the default
groups shipped with InfoPortal.

SYSTEM DEFAULTS
For al newly-created documents and folders:

¢ All permissions are denied.

e All are Hidden when created, meaning they are not visible to others.

e Members of Groups Authors, Administrators, and Subadmins are granted read/
write/del ete access.

*  The creator of adocument or folder is explictly given full access.

e Members of Group Allusers are granted read-only access.

You can select multiple users or groups to which to apply permissions. Granting
Administrator privileges (which includes Site Administrator and Account
Administrators) gives Full Access to the document, which cannot be denied except by
another Administrator. Owner does not grant any special privileges, but rather has the
same privileges as other Content Publishers. It isfor informational purposes only, to
denote who created the document or folder.
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The following table lists the avail able permission options:

Permission Option* Explanation
_Deny Access (RWDS) No access is allowed to the document or folder.
Full Access (rwds) Allows the Target User or Group to view, change,

and delete the document or folder and its associated
metadata. This option also grants access to set per-
missions. Inheritance rules apply.

Read (r) Allows the Target User or Group to view the docu-
ment or folder. This option also grants access to
view, but not change, the metadata. Inheritance
rules apply.

Read Only (rWDS) Allows the Target User or Group to view the docu-
ment or folder and its associated metadata. This
option explicitly denies changing, deleting, and set-
ting permissions that could otherwise be inherited
from higher levels.

Read/Write (rw) Allows the Target User or Group to view and change
the document or folder and its associated metadata.
Inheritance rules apply.

Read/Write Only (rwDS) Allows the Target User or Group to view and change
the document or folder and its associated metadata.
This option explicitly denies deleting and setting per-
missions that would otherwise be inherited from
higher levels.

Read/Write/Delete (rwd) Allows the Target User or Group to view, modify, and
delete the document or folder and its associated
metadata. This option does not allow setting permis-
sions on the document or folder. Inheritance rules

apply.
Deny Write/Delete/Set Permissions Explicitly denies changing and deleting the docu-
(WDS) ment or folder, and setting permissions on the docu-

ment or folder that would otherwise be inherited
from higher levels.

Deny Delete/Set Permissions (DS) Explicitly denies deleting the document or folder,
and setting permissions on the document or folder
that would otherwise be inherited from higher levels.

Deny Set Permissions (S) Explicitly denies setting permissions on the docu-
ment or folder that would otherwise be inherited
from higher levels.

* |n the Permission Option column of the preceding table, the lower-case lettersin
parentheses list elements that are permitted; the capital lettersin parentheses list
elements that are denied.

Permissions are hierarchical; that is, folders and documents at lower levelsinherit
permissions from higher levels, unless you explicitly deny them. Use the “Only”
permission options to do this; they stop the selected User or Group from inheriting
permissions from a higher level. For example, if the Root directory folder grants read/
write/delete permission for Content Publishers, to keep a lower-level directory folder
from being deleted, set Read/Write Only permission for the group Content Publishers
on that particular directory folder.

Assigning conflicting permissions to two different groups on the same folder could
create ambiguity if a user belongs to both groups. In general, it is recommended that
such a situation be avoided by assigning the conflicting permissions to different
directory levels so that the evaluation order is explicit.

Failing that, if two groups have conflicting rights on the same document or folder, the
smaller (subset) group’s permissions are handled first, then the larger group’s
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permissions. For example, if Deny Delete/Set Permissionsis set for the Alluser group
(all usersin the system), and Full Accessis set for the Documentation group (a subset
of Allusers), then Usersin the Documentation group could delete and set permissions,
but all other users who are not in the Documentation group could not.

If two peer groups of the same size have conflicting permissions on the same
document or folder, the results are ambiguous. You can avoid this ambiguity by
keeping in mind another rule of permissions. you cannot allow or deny permission a
level below, then do the opposite alevel above (think of it as once denied, aways
denied).

The“direction” you use when setting up permissions is from bottom to top in the
directory structure. Permissions start at the bottom, but can trickle down from the top;
if atrickle-down permission conflicts with apermission at alower level in the
directory structure, the lower-level permission takes precedence.

RULES OF PERMISSIONS

e Permissions already granted cannot be denied.

e Permissions already denied cannot be granted.

e Evaluation order at peer level isindividual, then subset groupsin order from small-
est to largest, then group.

For example, let us assume that Documentation and Training are separate groups of
equal size. User X isamember of both groups. User X wantsto be able to delete
Training Documentation Catalog document in the Training Documents folder, but
User X does not want anyone else in Training to be able to delete it.

l‘ -
©» Training Documents
Training Documents

| Trainine Documentation Catalog doc B
Traitung Documentation Catalog

Add the Training group with Deny Delete/Set Permissions set for the folder
containing the document, which is the level above:

Settings:

Type [Growp =] 5 | ~| | Permissions [visible =]

Target ITraining

Deny Delete/Set Permissions (D)

InfoPortal
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Result;

Marme:
fTraining Documents
Mote: Directory access control sethings are mhented by all subdirectories.

Directory Permissions

authors
administrators
subadmins
allusers

Training

Fermission Hidden

ReadMVrite/Delete (rwd)

ReadMVrite/Delete (rwd) Mo
ReadMVrite/Delete (rwd) Mo
Read i) Mo

Deny Delete/Set

Permissions (D5) o

Security (files and folders) Overview

Admin

Mo
Mo
Mo

Mo

wmer
Mo
Mo
Mo
Mo

Mo

Then add the Documentation group with Full Access permission set for the document

itself:

Settings:

Type IGrnup 'I Y I

=l Permissions

Target IDDcu.mentatiDn

|‘u’i5ible vI

Revert

Add

Rermove

Result;

MName:
fTraining DocumentsiTraining Documentation Catalog.doc

"

| E| = || E)

3

Type
Group
Group
Group
Group
User
Group

Group
Group

Target
authors
administrators
subadmins
allusers
admin
MNorthPoint

Training

Documentation

File Permissions

Fermission Hidden

ReadMVrite/Delete (rwd)
ReadMVrite/Delete (rwd) Mo
ReadMVrite/Delete (rwd) Mo
Read i) Mo
Full Access (rwds) Mo
Deny Access (RWDS) fes
Denj,r_De_IetefSet Mo
FPermissions (D5)

Full Access (rwds) Mo

hladify

Admin

Mo
Mo
Mo
fes
Mo

Mo

Mo

Owiner
Mo
Mo
Mo
Mo
Mo
Mo

Mo

Mo
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When a person from the Training Group other than User X triesto delete the
document, they cannot do so and the following message displays:

Microsoft Internet Explorer

1\

If two peer groups of the same size do not have conflicting permissions on the same
document or folder, the results are determined by the chronological order in which
permissions were applied; first in, first applied.

Adding File Permissions

This procedure displays the File Permissions screen for the selected document so you
can view the current permissions, and add others. For an overview of permissions, see
“Security (files and folders) Overview,” page 3.42.

1. Inthe Content Area, click on the document icon to select it.
* A check mark displays on theicon:

%l & PortalPlanning doc Planning Portal Content

2. Inthe Side Navigation Bar, click on the Properties menu triangle to expand it.

3. Click on the Security link.
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» TheFile Permissions screen displays:

File Permissions

MName:
{Portal Info/PortalPlanning.doc

| Fermission Hidden | Admin Chainer
2| Group authors ReadMrite/Delete (rwd) Mo Mo
2| Group administrators ReadMrite/Delete (rwd) Mo Mo Mo
2| Group subadmins ReadMrite/Delete (rwd) Mo Mo Mo
2| Group allusers Read {f) Mo Mo Mo

Type [User =] & | =] Permissions | +]

Targetl |Den3,r Access (RWDE) j

Revert Add Remave hladify

« The upper part of the screen displays the current file permissions. The 2| icon
to the left of the Type field denotes permissions that are inherited from a higher

level. If you click onthe 2| icon, the permissionsin the next higher level dis-

play (in the example above, clicking on 2| shows you the permissions set for
the Portal Info folder). See“ Security (files and folders) Overview,” page 3.42 for
details on permission inheritance.

» Thelower part of the screen (in gray) is where Content Publishers can change or
remove permissions.

4. Inthelower part of the screen (in gray), select User or Group from the Type drop-
down list.

5. Clickonthe ™ jcontothe right of the Type field.
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» Depending on whether you selected User or Group, the Search Users or Search
Groups screen displays, respectively:

Search Users

Login D ;I ||:|:|ntains ;I | Submit |

Search Groups

Group D ;I ||:|:|ntains ;I | Submit |

6. Enter your search criteria.

e See“Finding aUser,” page 4.17 for details on finding users.
7. Click on the Submit button.

» The search results display:

¥ Netscape

Search Users

|L|:|gin 10 j ||:|:|ntains j I* =ubmit |

Login 1D Firstname Lastname
Add  david David Zoleman
Add  julie dulie Zallahan
Add  marco Marco Earay
Add  wirginia Yirginia dickson
Add  anonymous
Add  admin admin

8. Click onthe Add link to the left of the user(s) or group(s) you wish to select.
« You can select multiple users or groups to which to apply permissions.

9. Click onthe = icon to close the Search window.
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* TheTarget field displays the ID of the User(s) or Group(s).

Target |iulie

» |f security has been set for an individual, that user's Login ID will display in the
Target fidd. If Group security permission has been set, the name of that group
will show here. It is possible to have multiple users or groups or a combination of
users and groups in each security entry.

10. Select Blank, Owner or Administrator from the drop-down list to the right of the

% jcon.

« TheBlank option allows inheritance from higher levels. Administrator grants
Full Accessto the document that cannot be denied except by another Administra-
tor. Owner does not grant any specid privileges, it has the same privileges as
other Content Publishers; it isfor informational purposes only.

11. In the Permissions area, select Blank, Hidden, or Visible from the upper drop-down
list.

e The Blank option allows inheritance from higher levels. The Hidden and Visible
options set explicitlywhether to hide or show the document to the selected users
or groups. Hiding a document can be used as a shortcut: rather than denying
access, then going back and reseting permissions to allow access, you can set
permissions once, then hide the document from those particular users or groups
until you are ready to grant them access.

12. Select a permission option from the lower drop-down list.

|Den3,r Access (RWDS) j

Full Access (rwds)
Read i)

Read Only ("WD3)

ReadMVrite (re)

ReadMvrite Only (reD5)
ReadMVrite/Delete (rwd)

Deny Write/Delete/Set Permissions (WDS)
Deny Delete/Set Permissions (D)

Deny Set Permissions (5)

e See"“Security (files and folders) Overview,” page 3.42 for explanations of the
various permission options.
13. Click on the Add button.

Adding File Permissions

Note

Allowed permissions
are lower case, denied
are Upper Casein this
list.
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Note

You must Save for the
new permissions to
take effect.

e Theusers or groups and their permission settings display in the File Permissions
window.

File Permissions

MName:
{Portal Info/PortalPlanning.doc

| Fermission Hidden | Admin Chainer
2| Group authors ReadMrite/Delete (rwd) Mo Mo Mo
2| Group administrators Read/Write/Delete (rwd) Mo Mo Mo
2| Group subadmins ReadMrite/Delete (rwd) Mo Mo Mo
2| Group allusers Read (1) Mo Mo Mo
0 User marco Egmiggﬁfﬁﬁggm No No Mo
O User virginia Deny Write/Delete/Set Mo Mo Mo

Permissions (WDS)

Save |
Type [User =] & | ~|  |Permissions | +]

Target I |Den3,r Access (RWDE) j

Revert Add Remave hladify

14. Click on the Save button.
» Thechangeis saved and you return to the Category view.

15. Click on the Refresh button to deselect the document icon in the Con-
tent Area.

Changing File Permissions

This procedure displays the File Permissions screen for the selected file so you can
view the current permissions, select those you wish to change, and make the changes
to them.

1. Inthe Content Area, click on the document icon to select it.
e A check mark displays on theicon:

%l & PortalPlanning doc Planning Portal Content

2. Inthe Side Navigation Bar, click on the Properties menu triangle to expand it.

Properties

3. Click on the Security link.
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Removing File Permissions

» TheFile Permissions screen displays:

File Permissions

MName:
{Portal Info/PortalPlanning.doc

Target Fermission Hidden | Admin Owiner
2| Group authors ReadMrite/Delete (rwd) Mo Mo Mo
2| Group administrators Read/Write/Delete (rwd) Mo Mo Mo
2| Group subadmins Read/Write/Delete (rwd) Mo Mo Mo
2| Group allusers Read (1) Mo Mo Mo

Deny Write/Delete/Set
P
User marco Permissions (WD) Mo Mo Ma
e Deny Write/Delete/Set
P
User Yirginia Permissions (WD) Mo Mo Ma
Save |
Type [user =] A | ~|  |Permissions | +]
Target I |Den3,r Access (RWDS) =l
Revert Add Remave hladify
Click on the radio button for the user or group permissions you wish to change.
e Thesettings display in the lower (gray) part of the File Permissions screen.
Enter the appropriate changes.
Click on the Modify button.
» Thechanges display in the File Permissions screen.
Click on the Save button. Note

» Thechangeis saved and you return to the Category view.

Click on the Refresh button to deselect the document icon in the Con-
tent Area.

Removing File Permissions

This procedure displays the File Permissions screen for the selected file so you can
view the current permissions and select those you wish to remove.

In the Content Area, click on the document icon to select it.
e A check mark displays on theicon:

%l & PortalPlanning doc Planning Portal Content

You must Save for the
new permissions to
take effect.
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2. Inthe Side Navigation Bar, click on the Properties menu triangle to expand it.

Properties

3. Click on the Security link.
» TheFile Permissions screen displays:

File Permissions

MName:
{Portal Info/PortalPlanning.doc
| Target Fermission Hidden | Admin Owiner
2| Group authors ReadMrite/Delete (rwd) Mo Mo Mo
2| Group administrators Read/Write/Delete (rwd) Mo Mo Mo
2| Group subadmins ReadMrite/Delete (rwd) Mo Mo Mo
2| Group allusers Read (1) Mo Mo Mo
Deny Write/Delete/Set

o

User marco Permissions (WD) Mo Mo Ma
O User virginia Deny Write/Delete/Set Mo Mo Mo

Permissions (WDS)

Save |
Type [User =] & | ~|  |Permissions | +]

Target I |Den3,r Access (RWDE) j

Revert Add Remave hladify

4. Click on the radio button for the user or group permissions you wish to delete.
e Thesettings display in the lower (gray) part of the File Permissions screen.
5. Click on the Remove button.
Note » The changes display in the File Permissions screen.
You must Save for the 6. Click on the Save button.

new permissions to . : ;
take effect. The changeis saved and you return to the Category view.

Adding Category Permissions

This procedure displays the Directory Permissions screen for the selected folder so
you can view the current permissions and add others.

By system default, all newly-created folders have all permissions denied and are
Hidden (not visible to others).

1. Inthe Content Area, click on the folder icon to select it.
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» A check mark displays on the icon:

' v; Documentation
Technical Documentation

2. Inthe Side Navigation Bar, click on the Properties menu triangle to expand it.

3. Click on the Security link.
¢ The Directory Permissions screen displays:

Directory Permissions
Marme:
Documentation
Mote: Directory access control sethings are mhented by all subdirectories.

| Fermission Hidden | Admin Chainer
2| Group authors ReadMrite/Delete (rwd) Mo Mo
2| Group administrators Read/Write/Delete (rwd) Mo Mo Mo
2| Group subadmins ReadMrite/Delete (rwd) Mo Mo Mo
2| Group allusers Read {f) Mo Mo Mo
T ser admin Full Access (rwds) Ma Ma as

Type [User =] 2 | =] Permissions | +]

Target I |Den3,r Access (RWDE) j

Revert Add Remave hladify

+ Theupper part of the screen displays the current directory permissions. The 2
icon to the left of the Type field denotes permissions that are inherited from a

higher level. If you click onthe @ icon, the permissionsin the next higher level

display (in the example above, clickingon 2| shows you the permissions set for
the Portal Info folder). See “ Security (files and folders) Overview,” page 3.42 for
details on permission inheritance.

* Thelower part of the screen (in gray) is where you add, change, and remove per-
missions.
4. Select User or Group from the Type drop-down list.

5. Clickonthe ™ icontothe right of the Typefield.
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» Depending on whether you selected User or Group, the Search Users or Search
Groups screen displays, respectively:

¥ Netscape

Search Users

|L|:|gin 10 j ||:|:|ntains j I* =ubmit |

Login 1D Firstname Lastname
Add  david David Zoleman
Add  julie dulie Zallahan
Add  marco Marco Earay
Add  wirginia Yirginia dickson
Add  anonymous
Add  admin admin

6. Enter your search criteria.
e See“Search,” page 1.4, “Finding aUser,” page 4.17, or “Finding a Group,” page
4.28 for details on searching.
7. Click on the Submit button.
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» The search results display:

¥ Netscape

Search Users

|L|:|gin 10 j ||:|:|ntains j I* =ubmit |

Login 1D Firstname Lastname
Add  david David Zoleman
Add  julie dulie Zallahan
Add  marco Marco Earay
Add  wirginia Yirginia dickson
Add  anonymous
Add  admin admin

8. Click onthe Add link to the left of the user(s) or group(s) you wish to select.
« You can select multiple users or groups to which to apply permissions.

9. Click onthe X icon to close the Search window.
* ThelD of the User or Group displaysin the Target field.
10. Select Blank, Owner or Administrator from the drop-down list to the right of the

% jcon.

* TheBlank option allows inheritance from higher levels.

«  Owner does not grant any special privileges, but rather has the same privilegesas
other Content Publishers. It isfor informational purposes only, to denote who
created the document or folder.

e Administrator grants Full Accessto the folder that cannot be denied except by
another Administrator.

11. In the Permissions area, select Blank, Hidden, or Visible from the upper drop-down
list.

» TheBlank option allows inheritance from higher levels.

e TheHidden and Visible options set whether to hide or show the folder to the
selected users or groups. Hiding afolder can be used as a shortcut: rather than
denying access, then going back and reset permissions to allow access, you can
set permissions once, then hide the folder from those particular users or groups
until you are ready to grant them access.
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12. Select a permission option from the lower drop-down list.

j

Full Access (rwds)
Read i)

Read Only ("WD3)

ReadMVrite (re)

ReadMvrite Only (reD5)

ReadMVrite/Delete (rwd)

Deny Write/Delete/Set Permissions (WDS)
Deny Delete/Set Permissions (DS)

Deny Set Permissions (5)

e See“Security (files and folders) Overview,” page 3.42 for explanations of the
various permission options.
13. Click on the Add button.
» Theusersor groups and their permission settings display in the Directory Per-
mi ssions window.

Directory Permissions

Marme:
Documentation
Mote: Directory access control sethings are mhented by all subdirectories.

Fermission Hidden | Admin Oiwner

Group authors ReadWrite/Delete (rwd) Mo
7| Group administrators ReadWrite/Delete (rwd) Ma Ma Mo
7| Group subadmins ReadWrite/Delete (rwd) Ma Ma Mo
7| Group allusers Read (1) Mo Mo Mo
T ser admin Full Access (rwds) Ma Ma as
C User julie Full Access (rwds) Ma Yes Ma
Save |
Type [User =] 2 ~| | Permissions | -]
Target I |Den3,r Access (RWDS) =l
Revert Add Remave hladify
14. Click on the Save button.
Note + Thechangeis saved and you return to the Category view.
You must Save for the
new permissions to 15. Click on the Refresh button m to deselect the folder icon in the Content
take effect. Area.
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Changing Directory Permissions

This procedure displays the Directory Permissions screen for the selected folder so
you can view the current permissions, select those you wish to change, and make the
changes in them.

1. Inthe Content Area click on the folder icon to select it.
» A check mark displays on the icon:

v:' Documentation
Technical Documentation

2. Inthe Side Navigation Bar, click on the Properties menu triangle to expand it.

Properties

3. Click on the Security link.
e TheDirectory Permissions screen displays.

Directory Permissions
Marme:
Documentation
Mote: Directory access control sethings are mhented by all subdirectories.

| Fermission Hidden | Admin Chainer
7| Group authors ReadWrite/Delete (rwd) Ma Mo
7| Group administrators ReadWrite/Delete (rwd) Ma Ma Mo
7| Group subadmins ReadWrite/Delete (rwd) Ma Ma Mo
7| Group allusers Read (1) Mo Mo Mo
T ser admin Full Access (rwds) Ma Ma as
C User julie Full Access (rwds) Ma Yes Ma

Save |
Type [User =] 2 =l Permissions | +]

Target I |Den3,r Access (RWDE) j

Revert Add Remave hladify

4. Click on the radio button for the user or group permissions you wish to change.

* The settings display in the lower (gray) part of the Directory Permissions screen.
5. Enter the appropriate changes.
6. Click onthe Modify button. Note

e The changes display in the Directory Permissions screen.

. You must Save for the

7. Click on the Save button. new permissions to

* Thechangeis saved and you return to the Category view. take effect.
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8. Click on the Refresh button m to deselect the document icon in the Con-
tent Area.

Removing Directory Permissions

This procedure displays the Directory Permissions screen for the selected folder so
you can view the current permissions and select those you wish to remove.

1. Inthe Content Area click on the folder icon to select it.
» A check mark displays on the icon:

v:' Documentation
Technical Documentation

2. Inthe Side Navigation Bar, click on the Properties menu triangle to expand it.

3. Click on the Security link.
e TheDirectory Permissions screen displays.

Directory Permissions

Marme:
Documentation
Mote: Directory access control sethings are mhented by all subdirectories.

Target Fermission Hidden | Admin Owiner

Group authors ReadWrite/Delete (rwd) Mo
7| Group administrators ReadWrite/Delete (rwd) Ma Ma Mo
7| Group subadmins ReadWrite/Delete (rwd) Ma Ma Mo
7| Group allusers Read (1) Mo Mo Mo
T ser admin Full Access (rwds) Ma Ma as
C User julie Full Access (rwds) Ma Yes Ma
Save |
Type [User =] 2 =l Permissions | vI
Target I |Den3,r Access (RWDS) =l
Revert Add Remave hladify

4. Click on the radio button for the user or group permissions you wish to delete.

e Thesettings display in the lower (gray) part of the Directory Permissions screen.
5. Click on the Remove button.

¢ The changes display in the Directory Permissions screen.
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6. Click on the Save button.
« Thechangeis saved and you return to the Category view. Note
You must Save for the

new permissions to

Checking PDF and HTML Links teKe effect
InfoPortal is able to monitor the status of hyperlinks between HTML and PDF
documents within the repository and, if necessary, fix broken links. When an HTML
or PDF document is loaded into the system via Add a Document (see “Adding a
Document,” page 3.23), or viaWebDAV which isavailable with the Microsoft Internet
Information Server platform of the software, InfoPortal automatically enters any
documents into its database. If either the source or target document for a hyperlink is
moved within the system, InfoPortal will update the link in the originating document
and modify the reference to the target document.

The Check Links function allows the Content Publisher to ascertain that the linksin a
given document are valid, and also to make sure that any target or originating
documents referenced by the document are still available to InfoPortal. InfoPortal is
not able to manage links that lead outside of the InfoPortal content repository.

This procedure verifies PDF and HTML links that occur in the sel ected document.
These links can be both internal (the target is inside the same document) and external
(the target is outside the document but still within the InfoPortal collection).

1. Inthe Content Area click on the document icon to select it.
» A check mark displays on the icon:

W WebSites htm Web Site List

2. Inthe Side Navigation Bar, click on the Properties menu triangle to expand it.

3. Click onthe Check Links link.
e ThelLink Status screen displays:

Link Status

o Good Link 38 Bad Link ? Unknown Link @ Referenced

d:\glyphica8?\docs'websites.htm
o http:ffwww glyphica.com/

R http: v onlyxint. comd

R http:/Awwer thehomstop. com/
o http:ffwww best. com/

e Consult the key at the top of the Link Status screen to determine your results.
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Viewing Document Version History

InfoPortal allows Content Publishers to add multiple versions of a document to the
system. Version Comments allow a quick mechanism to see differences between
versions of a document.

Versions may be viewed only in the Content Publisher view. Other users only have
access to search and download the most recent version of the document.

Although InfoPortal stores multiple versions of documents, the only PDF Rendition
kept isthe most recent one for the latest version of the document. If a PDF Rendition
is not made when the newest version is checked in, no PDF icon will display.

There are two ways of adding new Versions of a document:

e AddaDocument (using the Add Document function) with the same filename as an
existing document to a Category folder where the document exists.

¢ Check In adocument. This allowsthe documentsto have different filenames but still
be treated as versions of the sasme document.

This procedure displays the links to the present and past versions of the selected
document.

1. Inthe Content Area, click on the document icon to select it.
» A check mark displays on the icon:

d docsearchpdf searchmapver? sdr

3. Click onthe Version History link.




» The Version History screen displays for the document:

Version history for: Solarisinstall.doc

Yersion 1.2 (click to delete)

Date: 10/04/93 16:16:14
Checked in by: ken
Comment: This is the final copy

Yersion 1.1 (click to delete)

Date: 10/04/93 15:44:59
Checked in by: frank
Comment: Changes made to page 10

Yersion 1.0 (click to delete)

Date: 10/04/93 15:43:13
Checked in by: admin
Comment:

Deleting an Older Document Version

» Versionsarelisted in chronological order, with the most recent version displayed

first. The ﬁ icon displaysto the left of documents that have been del eted.

4. Click ontheversion link to view the document.

Deleting an Older Document Version

This procedure deletes older versions of a document that are placed under version

control.

1. Inthe Content Area click on the document icon to select it.

» A check mark displays on the icon:

d docsearchpdf searchmapver? sdr

2. Inthe Side Navigation Bar, click on the Properties menu triangle to expand it.

3. Click onthe Version History link.
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Deleting an Older Document Version

* The Version History screen displays:
Version history for: Solarisinstall.doc

Yersion 1.2 (click to delete)

Date: 10/04/93 16:16:14
Checked in by: ken
Comment: This is the final copy

Yersion 1.1 (click to delete)

Date: 10/04/93 15:44:59
Checked in by: frank
Comment: Changes made to page 10

Yersion 1.0 (click to delete)

Date: 10/04/93 15:43:13
Checked in by: admin
Comment:

4. Click onthe Click to Delete link next to the version title.
¢ A confirmation message displays.

localhost:82 - [JavaScript Application] [E3

@ Delete verzion 1.1°7

Cancel

-

5. Click onthe OK button.
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e Thelink isremoved. The ﬁ icon displaysto the left of document version num-
ber, and the word deleted displays to the right. The entry remainsin the Version
History screen, but you can no longer access the document.

Yersion history for: docsearch.pdf

Yersion 1.2 (click to delete)

Date: 03/11/99 16:51:12
Checked in by: admin
Comment: testing check in

ﬁ Version 1.1 (deleted)

Date: 03/10/99 15:28:06
Checked in by: admin
Comment: imoved from /docsearch pdf)

ﬁ Version 1.0 (deleted)

Date: 03/10/99 15:28:06
Checked in by: admin
Comment: imoved from /presentations/docsearch. pdf)

Viewing a List of All Discussions

This procedure displaysalist of al Discussion Groupsthat are in the current directory.
(thisincludes adirectory’s subdirectories starting from the point in the directory

where you are; therefore, if you want to see all Discussion Groups on the InfoPortal, Note
navigate to the home directory first). You can go directly to a specific Discussion Sesrss s em s
Group by clicking on the Discussion title link in the list. appear in User view;
1. Inthe Side Navigation Bar, click on the View menu triangle to expand it. they areonly visiblein
h the Content Publishing
VIEeW.

2. Click onthe All Discussions link.
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Viewing a Message

« Alist displays of al Discussion Groups on the InfoPortal :

5% Select a forum to hrowse:

Potential Clients

Trade Show Thermes
documentschat

ldeas for Portal Content
Mews Feature Wishlist

3. Click on aDiscussion title link to display the contents of that group.

Viewing a Message
This procedure displays an existing message within atopic. When a Content Publisher
clicks on atopic or message link in the Topic/Message area, the message displaysin
the Message Content area. The Message Content area displays the author of the
message, the date the message was posted, the message subject, and the message text.
This areaisread-only, it cannot be changed. If afileis attached to the message, alink
displaysto access thefile.

1. Navigate to the appropriate Discussion Group:

home : Tranng Documents

- -
" » Training Documents
Training Documents

fj-—f'{_{—.; suoeestions for Traming Topics

(= Training Format Preferences

o

2. Click on the appropriate Discussion Group link.

« Alternatively, you can navigate to the home directory, view all discussions, and
click on the appropriate Discussion title link. See “Viewing a List of All Discus-
sions,” page 3.63 for details.

» The Discussion Group topics display:

Suggestions for Training Topics

ZD File/Folder Permissions % cdavid) Thu, 09 Sep 1999 21:45:28 GMT

2 Setting up mailboxes gehris) Thu, 09 Sep 1999 21:56:57 GMT

2 Document review prOCESS (dawid) Fri, 17 Sep 1999 19:04:43 GMT

3. Click on thetopic link that you wish to view.
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Viewing a Message

» The Discussion window displays:

Discussion

GLYPHICA 4.¢.>

Suggestions for Training Topics

File/Folder Permissions % (david) Thu, 09 Sep 1000 21:46:28 GMT

. Full Day Session (julie] Thu, 09 Sep 1999 21:52:40 GMT
.. Split sessions over two days (diane) Thu, 09 Sep 1999 21:54:32 GMT

i rilisy g o

== I
4. Inthe Topic/Message area (left-hand window), click on the link for the thread you
wish to view.
e Theauthor’'s comments display in the Message Content area (right-hand win-
dow):

MNetscape

_ Discussion
R 4.¢.;

Suggestions for Training Topics

File/Folder Permissions % (david] Thu, 09 Sep 1000 21.46:28 GMT Author: david
FPosted on: | Thu, 09 Sep 1999 21:46:28 GMT

Subject: File/Folder Permissions
Attachment: | filepermissions. gif

. Full Day Session (julie] Thu, 09 Sep 1999 21:52:40 GMT
.. Split sessions over two days (diane) Thu, 09 Sep 1999 21:54:32 GMT

WWe need one or more sessions covering file and
folder permissions:

17 basics on how to set themn up

2) seweral scenarios to illustrate

4] _'ILILI

= (== |Document; Done
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Viewing an Attachment

When a Content Publisher clicks on atopic or message link in the Topic/Message

area, the message displaysin the Message Content area. The message may include an
attached file. This procedure displays the attached file.

1. Follow theinstructionsin “Viewing aMessage,” page 3.64 to view the message that
contains the attachment.

» Theauthor’'s comments and the attachment link display in the Message Content

area (right-hand window):

Discussion

GLYPHICA 4.¢.>

Suggestions for Training Topics

. Full Day Session (julie) Thu, 02 Sep 1090 21:52:40 GMT

i

File/Folder Permissions % (david) Thu, 00 Sep 1000 21:48:28 GMT

.. Split sessions over two days (disne) Thu, 09 Sep 19090 21:54:32 GMT

Nt

Author: david
Fosted on: | Thu, 02 Sep 1999 21:46:28 GMT
Subject: File/Folder Permissions

Attachment: | filepermissions. gif

We need one or more sessions covering file and
folder permissions:

1) basics on how to set them up

21 several scenarios to illustrate

= ==

|Document: Done

S = I e

i

2. Using theright mouse button, click on the attachment link in the Attachment field of

the message (Example: filepermissions.gif).
» Theattachment file displaysin a separate browser window:

3. Click on the close box [X] to close the attachment window.

Responding to a Topic

This procedure posts a response to a discussion thread.
1. Navigate to the appropriate Discussion Group:

home : Tranng Documents

- -
" » Training Documents
Training Documents

fj-—f'{_{—.; suoeestions for Traming Topics

(= Training Format Preferences

2. Click on the appropriate Discussion Group link.
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Responding to a Topic

« Alternatively, you can navigate to the home directory, view all discussions, and
click on the appropriate Discussion title link. See “Viewing a List of All Discus-
sions,” page 3.63 for details.

» The Discussion Group topics display:

home : Tranng Documents ;. Sugeestions for Tramme Topics

Suggestions for Training Topics

2 File/Folder Permissions gulie)wed, 25 Aug 1999 00:43:10 GMT

2 Aftributes gadaed, 25 Aug 1999 00:53:17 GMT

S5 Docurment Review Process ¢mand ived, 25 Aug 1999 00:52:37 GMT

7 Aents gohn)ived, 25 Aug 1999 01:00:45 GMT

0

3. Click on thetopic link to which you want to respond.
» The Discussion window displays:

GLYPHICA

Suggestions for Training Topics

File/Folder Permissions [julie] Wed, 25 Aug 1998 00:48:10 ST

" £ w—

i (== |Document; Done

4. Click onthelink for the thread to which you want to respond.
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Responding to a Topic

» Theauthor’'s comments display in the right-hand window:

GLYPHICA

Suggestions for Training Topics

File/Folder Permissions (juli=)Wed, 25 Aug 1999 004510 GMT Author; julie
Fosted an: | Wed, 25 Aug 1999 00:48:10 GMT
Subject: File/Folder Permissions
Attachment:

Meed a training session cowvering system
defaults, inheritance, and how conflicts are
handled. We should include a number of
typical scenarios.

’E|={D‘=| |Document; Done

5. Click on the Respond ﬁ icon.
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Responding to a Topic

» The New Response screen displaysin the left-hand window:

Discussion

GLYPHICA

New Response

Your Mame: david Authar: julie
Email Address; david@glyphica.com Posted on: | Wyed, 25 Aug 1999 00:48:10 GMT
Subject: | Subject: File/Folder Permissions
Attachment: S | M Attachment:
Post Ms | Cancel Post | Claar Ms | Meed a training session covering system
g g defaults, inhentance, and how conflicts are
;l handled. YWe should include a number of

typical scenarios.

[ == |Dacument: Done

" A w—

6. Enter atitlein the Subject field.
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Responding to a Topic
7. Enter your message in the text field below the buttons.

Mew Response

Your Marme: david
Email Address: david@glyphica.com
Subject: |Full Day Session

Attachment: S | Bruwse..:l

Fost Msg | Cancel Post | Clear M=g |

There's enough content here for a;l
full day of training. I suggest

we split it into two sSessions:
concepts in the morning and
zcenariozs in the afternoon.

[~

* Note that once a message is posted, only the Site Administrator can delete it.
8. Click on the Post Msg button.

« Your response displays as alink below the topic in the left-hand window:

Discussion

GLYPHICA

Suggestions for Training Topics

File/Folder Permissions [julie) wed, 25 Aug 1999 00:48:10 ST Author: Julie

. Full Day Session (david] Wed, 25 Aug 1990 01:12:05 GMT Fosted on: | Ved, 25 Aug 1933 00:48:10 GMT
Subject: File/Folder Permissions
Attachment:

Meed a training session covering system
defaults, inheritance, and how conflicts are
handled. We should include & number of
typical scenarios.

" 2l o

| == |Document: Done = e B e i

9. Usethe Navigation Bar buttons to go to other topics and messages.
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10. Click onthe Xl icon to close the Discussion window.

Generating a PDF Rendition

There are two types of Adobe PDF filesin InfoPortal: standard PDF, where a PDF
original has been uploaded to the Portal; and PDF Rendition, which is created from
another document format during the upload process to InfoPortal. If a Glyphica
Satellite server is connected to InfoPortal, this procedure may be used to create a PDF
Rendition from the following file formats:

e MSWord

e  MSExcd

¢ MS Powerpoint

e TIFF (including multi-page TIFFs)
o Text

* Adobe PageM aker

¢ Adobe FrameMaker

e PostScript

« HTML

1. Click on adocument icon to select it.

Name " TTie T lockedby

W Discussion Group Guidelines htm Discussion Group Guidelines
¥ Welcome.fin Idessage from the CEOQ

2. Click on the Output menu triangle to expand it.

Dutput

» zenarate PDF
o MultiTiff 2 PDF
» Print

3. Click on Generate PDF.

« Anicon displaysthat alternates between ' and =" . When the PDF is finished

generating, the icon displays as L .

&l ¥ Welcome fin Idessage from the CEOQ

TIFF to PDF Conversions

This procedure converts scanned paper documents, in TIFF format, to machine-
searchable Image+Text Adobe PDF documents. (This option requires an Adobe
Capture hardware key. If thisis not installed on the server, this function will not work).
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TIFF to PDF Conversions

1. Click on one or more document icons to select them.

Name ———TTite T lockedby

&l arnystatg. if Lny's Monthly Status
Tt ballstatus. tif’ Ball's Wonthly Status
't samnstatus. tif Sam's Monthly Status

2. Click on the Output menu triangle to expand it.

Dutput
» enarate PDF

o MultiTiff 2 PDF
# Frint

3. Click on the MultiTiff 2 PDF link.
e The Converting Tiesto PDF screen displays:

Converting TIFs to PDF

Order File Arrange

1 iSales/Field Reportsfamystatus tif x| x|
2 [SalesField Reportsibillstatus tif Al =X
3 [Sales/Field Reportsisamstatus tif = 3%

will be converted to

|fSaIESIFieId Reportsfamystatus.t pdf

Submit |

4. Clickonthe =/ or ! icon to change the order in which documents are converted.

5. Click onthe %/ icon if you want to delete adocument from the conversion queue.

» Thisdoes not delete the document, it just tells InfoPortal not to create a PDF
Rendition for it.

6. Click on the Submit button.

e The documents are converted to one PDF Rendition as an aggregate of the
selected TIFF files. If the documents fail to convert, this message displays:

206.86.239.40:82 - [JavaScript Application] [E3

& TIFF to PDF conversion failed!

¢ You must contact your Site Administrator to find out why this process failed.
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Delete PDF Rendition Files

Delete PDF Rendition Files

There are two types of PDF filesin InfoPortal: standard PDF, and PDF Rendition,
which is created from another document format.

You delete a standard PDF file just like you delete other uploaded files (see “ Deleting

aDocument or Folder,” page 3.27 for details). You can delete a PDF Rendition in two

ways.

e Deéleting the original document, which also deletes the PDF Rendition (see “ Delet-
ing a Document or Folder,” page 3.27).

* Re-uploading the original document and not making a Rendition (see “Adding a
Document,” page 3.23).

Printing a Single Document

InfoPortal allows Content Publishersto select a particular document and request the
InfoPortal Server to print the document to a network-attached or hardware-attached
printer. InfoPortal can print only documents that are either PDF format or one of the
document types that InfoPortal supports for conversion: MS Word, MS Excel, MS
PowerPoint, Adobe PageM aker, Adobe FrameM aker, plain text, HTML, and
Postscript. Printing is not available unless a Glyphica Satellite Server is connected to
InfoPortal.

1. Click on adocument icon to select it.
2. Click on the Output menu triangle to expand it.

Dutput
# Generate PDF

o MultiTiff 2 PDF
# Frint

3. Click on Print.
e The Print Files screen displays.

Print files

1 /Documentation/docsearch. pdf x|

Select a printer

How many copies: IT

Submit |

ument.)
4. Select aprinter from the Select a Printer drop-down list.
Type anumber in the How Many Copiesfield if you want more than one.
6. Click on Submit.

o
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Printing Multiple Documents

» The document prints and the Print Files screen disappears from the Content
Area

Printing Multiple Documents
InfoPortal allows Content Publishersto select afolder and request the InfoPortal
Server to print all the documentsin that folder to a network-attached or hardware-
attached printer. InfoPortal can print only documentsthat are either PDF format or one
of the document types that InfoPortal supports: MSWord, MS Excel, MS PowerPoint,
Adobe PageM aker, Adobe FrameM aker, plain text, HTML, and Postscript.

1. Click on the document icons to select them.
2. Click on the Output menu triangle to expand it.

Dutput
# Generate PDF

o MultiTiff 2 PDF
# Frint

3. Click on Print.
e The Print Files screen displays.

Print files

1 /Sales/Meeting Q3 Projections.ppt v X
2 /Sales/Proposal Template fm < =
3 /Sales/03 Projections xls - X

Select a printer

How many copies: IT

Submit |

4. Click onthe =| or *| icon to change the order in which documents print.
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6. Select aprinter from the Select a Printer drop-down list.

Print files

1 iSales/Meeting 23 Projections.ppt v x|
2 /Sales/Proposal Template fm - v x|
3 /Sales/Q3 Projections xls - X

Select a printer

|Sate|llte 1. % FIrl\SalesidainiHP. =

Eatcllte 1. FItVAGmiHE Off cedet Pro 11500
Satellite: 1; WFIrTWarketing; ;

How many copies: IT

Submit |

» Thefiles can be sent to an attached printer or any printer available on the net-
work.
¢ Theitemsthat appear between the ; are designated by the system administrator
for that particular printer. These areas are the description and location areas of
the printers as entered on the printer software itself.
7. Typeanumber in the How Many Copiesfield if you want more than one.
8. Click on Submit.
e The documents print and the Print Files screen disappears from the Content
Area.

Subscribing to a Document or Folder

Subscribing to a Document or a Folder is essentially setting notification for yourself
on thisitem, should something be modified or added. Subscription notifications
appear in the Subscriptions box of each Content Publisher's My Portal view, or are
sent to the Subscriber via standard email. (See “My Portal,” page 2.1 for information
concerning My Portal views.)

1. Click on the document or folder icon to select it.

' ¥ Fortune100

Fortune 100 Companies

2. Click on the File menu to expand it.

3. Cllck on Subscrlbe subription under new.
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Changing or Deleting a Subscription

» The Notification Type screen displays.

Notification Type

& Email
© MyPaortal

Submit |

4. If you wish to have the notification concerning this document or folder sent to you
viaemail, choose Email. If you wish to see the notification in your My Portal view,
choose MyPortal.

5. Click on Submit.

* You return to the document directory.

6. Click onthe Refresh button m in the Top Navigation Bar to uncheck the
document or folder icon.

e Subscribing automatically creates an Agent:

Agents for ISales/ProposalsiFortune100

Agent Hame Event Notification Enahled
admin .
[ _
T Created Modified WyPortal o
Add | Delste|  Disable/Enable |

» See“Editing an Agent,” page 3.85 for details on modifying the subscription
agent.

Changing or Deleting a Subscription

This procedure can be used to change to another notification type, or to unsubscribe
from the document or folder.

1. Click on the document or folder icon to select it.

' ¥ Fortune100

Fortune 100 Companies

2. Click on the Subscription menu to expand it.

Subscription

scribe
dit

3. Click on Edit.
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Agent Overview

» The Notification Type screen displays:

Notification Type

" Email
& MyPaortal
" Unsubscribe

Submit |

» Thethird option, Unsubscribe, only shows on itemsthat are already subscribed
to by that Content Publisher.

4. Choose the appropriate option.
5. Click on Submit.
e If you selected Unsubscribe, a confirmation message displays:

hyperstate - [JavaScript Application] [E3

& subscription removed

6. Click onthe OK button.
* You return to the document directory.

7. Click on the Refresh button m in the Top Navigation Bar to uncheck the
document or folder icon.

Agent Overview

Agents are a powerful workflow tool included with the InfoPortal package. A basic
overview of Agentsis as system-resident queries or “watchers’ that can monitor
activities associated with Categories or individual documentsin the system, and then
send notifications to Users or Groups concerning those activities.

There are two types of Agents. Document Agents and Folder Agents. Document
agents can “watch” a particular document for changes, modifications, movement,
deletions, etc. and notify the Agent's targets (the original setter of the Agent, and
anyone named to the Agent as an interested party). A Folder Agent is even more
powerful. It can monitor the status of items within the entire Category and execute
searches on any documents that are modified, deleted, added, copied, etc. If the search
criteria are satisfied, then the Agent sends a customizable message to the target
audience.

Creating a Document Agent
This procedure creates an Agent for a document.
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Creating a Document Agent

1. Click on adocument icon to select it.

Name ———TTitle ] Lockedby

W InfoPortalQandd pdf

2. Click on the Agent menu.

Agent

e The Agents screen displays.

Agents for IPortalDocsiinfoPortalF GandA. pdf
Agent Hame Event NotificationEnabled

Add | Delste|  Disable/Enable |

3. Click on the Add button.
» The Create/Modify Your Agent screen displays:

Create/Modify your agent

Agent Mame:™ |

Events:™

Type: INntiﬁcatinn vI
nextl

4. Typeanameinthe Agent Namefield.
5. Click on the event(s) for which you will receive notification.

* Use Shift+click to select items next to each other; use Control+click to select
items that are not next to each other.

6. Click on Next.
e The Notification Type screen displays:

Notification Type

& Email
© MyPortal

_next]

7. If you wish to have the notification concerning this document or folder sent to your
My Portal view, choose MyPortal. If you wish to send notification viaemail, choose
Email.
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Creating a Document Agent

» TheMyPortal option sends natification only to the person creating the Agent; the
Email option allows notification to be sent to multiple users.

8. Click on Next.

» |If you selected MyPortal, the agent is created and automatically enabled at this
point. If you selected Email, the Notification Form Details screen displays.

MNotification Form Details

Notify |admin

From |

EﬁnﬁlSubﬁctlAgent for §<uris> eve

-

Eimnail Text

[~
Save |

9. TypethelID(s) of the user(s) and/or group(s) who will receive notification of the
event in the Notify field.

10. Typeyour user ID in the From field.
11. If you wish, enter a different subject heading in the Email Subject field.

» The default message shown is a script that gives notification of the event from
the list of events you chosein Step 17.

12. Type any appropriate text in the Email Text field.

MNotification Form Details

Notify |admin

Fron1|admin

EﬁnmlSubﬁctIAgent for §<urisr eve

InfoPortal Q&k =]
training doo on

Ernail Text hyperstate changed.
[
Save |

13. Click on the Save button.
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Creating a Folder Agent

» Theagent is created and automatically enabled.
Agents for [Training DocumentsiinfoPortalQandA.pdf

Agent Hame Event Notification Enahled
™ QnAagent Modified Deleted Moved Email 4
Add | Delste|  Disable/Enable |

14. Click on the Refresh button m in the Top Navigation Bar to uncheck the
document icon in the Content Area.

Creating a Folder Agent
This procedure creates an Agent for afolder. The process is more involved than
creating a Document Agent, but it offers an additional search criteria.

1. Click onthefolder iconto select it.

o
f v Sales
Sales

2. Click on the Agent menu.

Agent

e The Agents screen displays:
Agents for ISales

Agent Hame Event Notification Enahled
Add | Delste|  Disable/Enable |

3. Click on the Add button.
e The Create/Modify Your Agent screen displays:

Create/Modify your agent

Agent Mame: * |
All Subcategaries [

Type: ISearch vI
nextl

4. Typeanameinthe Agent Namefield.

5. Click inthe All Subcategories check box if you aso want notification from folders
contained within this folder.
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Creating a Folder Agent

6. Select Search or Notification from the Type drop-down list.

Type Explanation

Search 5isplays the Search Builder, which allows Content PUDIiShers to
set query parameters on the Agent. When a selected action occurs
in the Category folder (Search Builder queries may not be set for
individual documents, only for actions), the Agent runs the Search
Builder query against the document(s) to see if the changes
include new information of interest to the Content Publisher or
Group.

Notification Tells the Agent to send an email or My Portal message to the
user(s) and/or group(s) specified in the Details screen.

7. If you selected Notification, skip to Step 16. If you selected Search, continue with
the next step.

8. Click on Next.
¢ If you selected Search, the Search Criteria screen displays:

Enter your search criteria

PortalFeed -
Search _I

Search Builder:

1

[Author =] [contains words 5] | [ =]
[Author =] [contains words 5] | [ =]
[Author =] [contains words 5] | [ =]
| Author =] |contains words =] |

_next]

» The Search parametersthat you select in the steps below display in the Portal -
Feed Search box.
9. Enter aword or phrase for your search criteria.
10. Select from the concept operator drop-down list (accrue with, and, or) if you wish to
combine this part of the search with other search criteria. Otherwise, the period indi-
cates the end of the search string.

Selection Search Results
“Period Ends the search string.
Accrue with Selects documents that include at least one of the search

elements you specify. The more search elements present,
the higher the priority for selecting the document.

And Selects documents that contain all of the search elements
you specify.
Or Selects documents that show evidence of at least one of

your search elements.
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Creating a Folder Agent

11. Select metadata fields from the first set of drop-down lists.

e Thelist isdynamically generated by the attributes currently existing in the data-
base, so what you see may be different than what displays here:

IAuthDr vI

Descriptian

Kewwords
Title
hienw_field_t

12. Select the appropriate relational operator from the second set of drop-down lists.

||:|:|ntains wiords j

equals
not equal to
less than

o=

greater than
=

begins with
ends with

« Thefollowing table describes these relational operators.

Selection Search Results

contains words Selects documents by matching the word or phrase you
specify with the values stored in a specific document
field. Documents are selected only if the search ele-
ments specified appear in the same sequential and con-
tiguous order in the field value.

contains substring Selects documents by matching the character string you
specify with a portion of the strings of the values stored
in a specific document field.

equals Selects documents whose document field values are
exactly the same as the search string you specify.

not equal to Excludes documents whose document field values are
exactly the same as the search string you specify.

less than Selects documents whose document field values are
less than the search string you specify.

<= Selects documents whose document field values are
less than or equal to the search string you specify.

greater than Selects documents whose document field values are
greater than the search string you specify.

>= Selects documents whose document field values are
greater than or equal to the search string you specify.

begins with Selects documents by matching the character string you

specify with the beginning characters of the values
stored in a specific document field.

ends with Selects documents by matching the character string you
specify with the ending characters of the values stored
in a specific document field.
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13. Select an item from the second concept operator drop-down list (accrue with, and,
or) if you wish to combine this part of the search with other search criteria. Other-
wise, the period indicates the end of the search string.

& v

accrue with
and
ar

14. Repeat Steps 3 through 5 for each line until you are finished setting up your search
criteria.
15. The search criteriadisplays in the PortalFeed Search field:

Enter your search criteria

PortalFeed InfoFortal 3.0 <and> Author = david <Dr>ﬂ
Search |y yehor = julie <and> Description
<ocontains> attributes

[
Search Builder:
|InfoPartal 3.0 and v
| Author x| |equals x| [aavia [or |
| Authar =] [equals =] f3uiie [ and =l
| Description =] [contains words 7] |attributes [. =l

I -] |contains words =] |
_next]

« You can modify the text of the search directly in the Portal Feed Search box as
well.
16. Click on Next.
» The Create/Modify Your Agent screen displays the Eventsfield:

Create/Modify your agent

Events:™

rest

17. Click on the event(s) for which you will receive natification (use Shift+click to
select items next to each other; Control+click to select items that are not next to each
other).
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Creating a Folder Agent

18. Click on Next.
« The Notification Type screen displays:

Notification Type

& Email
© MyPortal

_next]

19. If you wish to have the notification concerning this document or folder sent to you
viaemail, choose Email. If you wish to see the notification in your My Portal view,
choose MyPortal.

20. Click on Next.
e If you selected Email, the Search Form Details screen displays:

Search Form Details

notify |salesvPs Add: [Group =] A

ﬁonlidavid@glyphica.cnm

Esubjiﬂgent for $<urix ewve

The new hrochure has;ﬁ
heen added to the

etesxt FPortal. Please read

it hefore staff
meeting.

s
InfoPortal<and: ;ﬂ
Author <contains:
Dawvid <and> Title
<oontains> Brochure

query

|
Save I

21. Click onthe * icon.

e The Search Users or Search Groups screen displays.
22. Click the Add link next to the user(s) you want to add to the notification list.
23. Click on the X icon to close the Search Users window.

24. 1f you want to notify aall the menebers of a specific group, click on the Add drop-
down list and select Group.

* You may select a combination of individuals and groups for the Natify field.
e The Search Groups screen displays.
25. Click the Add link next to the group(s) you want to add to the notification list.
26. Click on the X icon to close the Search Groups window.

3.84 InfoPortal




Editing an Agent

27. Typeyour user ID inthe From field.
28. Type a subject heading in the Email Subject field.
29. Type any appropriate text in the Email Text field.
30. Click on the Save button.

» Theagent is created and automatically enabled.

Agents for ISales
Agent Hame Event Notification Enabled
™ SalesFldrAgent Modified Email 4
Add | Delste|  Disable/Enable |

31. Click on the Refresh button m in the Top Navigation Bar to uncheck the
folder icon.

Editing an Agent

This procedure modifies an existing Agent.

1. Click on the document or folder icon to select it.
2. Click on the Agent menu.

» Depending on whether you selected a document or folder, the Agentsfor <file
name> or Agents for <folder name> screen displays:

Agents for ISalesiField Repors

Agent Hame Event Notification Enahled

™ mStatusAgent Maodified Ermail 4
Add | Delste|  Disable/Enable |

3. Click on the agent name link.
e The Create/Modify Your Agent screen displays:

Create/Modify your agent

Agent Mame: * ImStatusAgEnt

All Subcategories W

_next]

4. Enter changes if needed.
5. Click on Next.
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Enabling/Disabling an Agent
* TheEventsfield displays:

Create/Modify your agent

Events:

Modified Links =]

_next]

6. Enter changesif needed (use Shift+click to select items next to each other; Con-
trol+click to select itemsthat are not next to each other).

7. Click on Next.
« The Notification Type screen displays.
Notification Type
% Email
© MyPartal

rest

8. Enter changesif needed.
9. Click on Next.
* Theagent ismodified and enabled.

Agents for ISalesiField Repors

Agent Hame Event Notification Enahled
™ mStatusAgent Modified Deleted MyP ortal 4
Add | Delste|  Disable/Enable |

Enabling/Disabling an Agent

This procedure enables or disables an existing Agent without deleting it, making it
available on an intermittent, as-needed basis.

1. Click on the document or folder icon to select it.
2. Click on the Agent menu.
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» Depending on whether you selected a document or folder, the Agentsfor <file
name> or Agents for <folder name> screen displays:

Agents for ISalesiField Repors

Agent Hame Event Notification Enahled
™ mStatusAgent Modified Deleted MyP ortal 4
Add | Delste|  Disable/Enable |

3. Click inthe check box to the | eft of the agent name.

Agents for ISalesiField Repors

Agent Hame Event Notification Enahled
M mStatusAgent Modified Deleted MyP ortal 4
Add | Delste|  Disable/Enable |

4. Click on the Disable/Enable button.
« A confirmation message displays.

hyperstate - [JavaScript Application] [E3

& agent(z] updated:

5. Click onthe OK button.

< If the agent was previously enabled, the agent is disabled and the check mark is
removed from the Enabled field of the Agents for <file name> or Agents for
<folder name> screen:

Agents for ISalesiField Repors

Agent Hame Event Notification Enahled
™ mStatusAgent Modified Deleted MyF ortal
Add | Delste|  Disable/Enable |

« |If the agent was previously disabled, the agent is enabled and a check mark dis-
plays in the Enabled field of the Agents for <file name> or Agentsfor <folder
name> screen.

Deleting an Agent
This procedure removes an existing agent.

1. Click on the document or folder icon to select it.
2. Click on the Agent menu.

Deleting an Agent
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Check Review Progress

» Depending on whether you selected a document or folder, the Agentsfor <file
name> or Agents for <folder name> screen displays:

Agents for ISalesiField Repors

Agent Hame Event Notification Enahled
™ mStatusAgent Modified Deleted MyP ortal 4
Add | Delste|  Disable/Enable |

3. Click inthe check box to the left of the agent name.

Agents for ISalesiField Repors

Agent Hame Event Notification Enahled
M mStatusAgent Modified Deleted MyP ortal 4
Add | Delste|  Disable/Enable |

4. Click on the Delete button.
e A confirmation message displays.

hyperstate - [JavaScript Application] [E3

& agent(z] removed:

5. Click onthe OK button.

» Theagent entry isremoved from the Agents for <file name> or Agentsfor
<folder name> screen:

Agents for ISalesiField Repors

Agent Hame Event Notification Enahled
Add | Delste |  Disable/Enable |

Check Review Progress
This procedure checks status on a document that has been sent for review.

1. Select My Portal from the Show drop-down list.

2. Inthe Sent for Review section of the Document Review Process window, locate the
title of the review document you wish to check.

Document Review Process - |

w  Sent for review (1)
+ Please review and comment fPoral InfoPoralPlanning. doc

w  Aweaiting my approval (0
A,

3. Click onthetitlelink.
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» The Status’Comments screen displays:

Status

URI

Comments

Fortal Info/FPortalFlanning.doc

Status

Mext person to review | diane

Title

Flease review and comment /Portal Info/FPortalFlanning . doc

Description

More examples added.

People (click to send email)

+ diane (next to review)

+ david
- Julie

¢ Thefollowing table describes the fields in the Status tab:

Field

Description

URI

Status
Title

Description

People

Displays the filename and directory of the document in review as a link.
Click on this link to view the document contents.

Displays the User ID of the next person to review the document.

Displays the message that reviewers see in their My Portal view when
it is their turn to review the document. It is the same as the Title field in
the Document Info/Review List screen (see “Start Review of a Docu-
ment,” page 3.20).

Displays your description or comments on the document before it was
sent for review. It is the same as the description you entered in the
Description field in the Document Info/Review List screen (see “Start
Review of a Document,” page 3.20).

Displays the list of selected reviewers in User ID format. The IDs are
also links to the reviewers’ respective email addresses. This is a con-
venience feature so you can send emails to the reviewers if you wish
to give them additional information.

Reviewing a Document

This procedure lets you look at the document that you were asked to review and enter
comments that subsequent reviewers and the originator can view when it is their turn

to review the document.
1. Select My Portal from the Show drop-down list.

Reviewing a Document
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Reviewing a Document

2. Inthe Awaiting My Approval section of the Document Review Process window,
locate the title of the document you wish to review.

Document Review Process a

w  Sent for review (0]
FAA
w  Aweaiting my approval (1)
+ Please review and comment
fPoralDocsdnfoPortalF Clands, pdf

3. Click on thetitle link.
» The Status’Comments screen displays:

T Connens Y

URI
fPoralDocsdnfoPortalF Clands, pdf

Status

Mext person to review : julie

Title

Please review and comment /PortalDocs/InfoPartalF CandA. pdf

Description

3 new G and As added at the end of the document.

Your Comments

Submit

tl;

People (click to send email)

* Julie (next to review)
jack

e e e s
= [ o o
o == [o
==

o
o
=
[=8

4. IntheURI field, click on thelink to view the document.
* The document opens in a separate window.
5. If you need to get clarification, click on the appropriate link in the People field.
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Reviewing a Document

» Thisdisplays an email window with the person’s email address in the Mailto
field. You can email other reviewers or the document originator (the originator is
alwaysthe last User ID listed in the People field).

6. Enter your review commentsin the Your Comments field of the Status tab.
7. Click on the Submit button.
» The Status tab changes to show the next person to review the document.

CRTER ™ Connents Y

URI
fPoralDocsdnfoPortalF Clands, pdf

Status

Mext person to review : jack

Title

Please review and comment /PortalDocs/InfoPartalF CandA. pdf

Description
3 new G and As added at the end of the document.

People (click to send email)

* Julie
* Jack (next to review)

++
[
==
=. =
[
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End a Document Review

« |f you click on the Comments tab, it shows the text you entered in the Your Com-
mentsfield:

——————— Wednesday, August 25, 1999 15:01:41 - ——————-—

julie:

la) Include a screen clip that shows
examples of Metadata fields.

1h) Discuss how Metadata relates to
searching in documents—--how it can
help users.

21 Use a table to list the supported
file types.

3] Give a couple of examples to
illustrate how Agents can be used.

* Inaddition, your My Portal view no longer shows the link in the Awaiting My
Approval section of the Document Process window:

Document Review Process - |

w  Sent for review (0]
A,

w  Aweaiting my approval (0
A,

End a Document Review

This procedure displays reviewer comments, then removes the link from the Sent for
Review section of the Document Process window.
1. Select My Portal from the Show drop-down list.

2. Inthe Sent for Review section of the Document Review Process window, locate the
title of the review document you wish to check.

Document Review Process - |

w  Sent for review (1)
+ Please review and comment fPoral InfoPoralPlanning. doc

w  Aweaiting my approval (0
A,

3. Click onthetitlelink.
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End a Document Review

» The Status’Comments screen displays:

AT Connens Y

URI
Fortal Info/FPortalFlanning.doc

Status

Finished
Femove from deskiop

Title

FPlease review and comment /Portal
Info/FortalPlanning . doc

Description
More examples added.

People (click to send email)
+ diane
+ david
* ulie

¢ When thereview is complete (meaning al reviewers have submitted comments
on the document), the Status field displays the message “Finished,” with a

Remove From Desktop button below it. In addition, the message “next to Note
review” does not display after anyone's name in the People figld. .
_ Reviewer comments
Click on the Comments tab to see all the comments. are deleted when you
The Comments tab displays reviewer comments: end the review. The

review is ended when

AT Comments you delete the link

from the Sent for
Review section of the
——————— Tuesday, August 17, 1999 13:47:57 ———————- Document Process
diane: Review in your My
I think we should change the order in Portal view. Make
which the exswmples appear. sure you make the

required changes to
the document before
——————— Tuezsday, August 17, 1999 13:49:03 -—-——-———- you delete the link.
cdawvid:
We should put bullet points denoting features
of our product that each example uses.
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End a Document Review

6. Copy the comments or incorporate the changes in the original document.
e The commentswill be deleted when you end the review.

7. Click on the Status tab.
e The Status tab information displays again.

AT Connens Y

URI
Fortal Info/FPortalFlanning.doc

Status

Finished
Femove from deskiop

Title
Flease review and comment /Portal
Info/FortalPlanning . doc
Description
More examples added.

People (click to send email)
+ diane
+ david
* ulie

8. Click on the Remove From Desktop button.
e A confirmation message displays.

Frocess has been remaoved from your deskiop

* All reviewer comments are deleted.

* |naddition, the link is removed from the Sent for Review section of the Docu-
ment Review Process window in your My Portal view:

Document Review Process - |

w  Sent for review (0]
A,

w  Aweaiting my approval (0
A,
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